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1 About this Book

This book describes various configuration settings and tasks that make an
openCRX administrator's life easier.

openCRX is the leading enterprise-class open source CRM suite. openCRX is
based on openMDX, an open source MDA framework based on the OMG's
model driven architecture (MDA) standards. This guarantees total openness,
standards compliance, a state-of-the-art component-based architecture, and
virtually unlimited scalability.

1.1 Who this book is for

The intended audience are openCRX administrators.

1.2 What do you need to understand this book

This book describes some of the settings and configurations an openCRX
administrator can use to control the behavior of openCRX.

1.3 Tips, Warnings, etc.
We make use the following pictograms:

Information provided as a “Tip” might be helpful for various reasons:
time savings, risk reduction, etc. - it goes without saying that we

fm advise to follow our guides meticulously
meticulous \muh-TIK-yuh-luhs\, adjective:
Extremely or excessively careful about details.
You should carefully read information marked with “Important”.
Ignoring such information is typically not a good idea.
Important

Warnings should not be ignored (risk of data loss, etc.)

T
arminn
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2 Prerequisites

This guide assumes that you have access to a properly installed instance of
openCRX 2.5.2 (for installation instructions, please refer to the guides available
from http://www.opencrx.org/documents.htm).

You can either follow the openCRX Server Installer documentation
(http://www.opencrx.org/server.htm) or you can do a manual installation of
openCRX following the installation guide for Tomat 6.



http://www.opencrx.org/opencrx/2.5/tomcat-6/openCRX_Installation_Tomcat-6.html
http://www.opencrx.org/server.htm
http://www.opencrx.org/documents.htm
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3 Security

In this chapter we will present a high-level overview of openCRX security and
discuss a few important issues.

We do not recommend learning about security with mission critical

data. Backup your data before you make changes if you are not

Waminu  certain what the consequences are! The risk of you being locked out

3.1

is real and the resources required to fix broken security settings
can not be overestimated!

The default settings should work for virtually all users; the probability
of getting yourself into trouble by changing default settings should
not be underestimated. Read and understand at least the basics
of openCRX security BEFORE you make any changes.

Introduction

3.1.1 Basic Concepts and Conventions

Each “real user” is represented by a Subject (e.g. "Guest”). Subjects are
managed by the openCRX Root administrator (admin-Root).

Each subject has an Application Login Principal (also called login id).
Application login principals are managed by the openCRX Root
administrator (admin-Root).

Each application login principal is assignhed to a subject (e.g. principal
“guest” is assigned to subject “"Guest”) and allows a “real user” to login.

A “real user” can have one or more additional segment login principals.
The Segment Login Principal has typically the same name as the
application login principal (e.g. “guest”) and grants a “real user” login
access to a segment. Segment login principals are managed by the
openCRX segment administrators (e.g. admin-Standard for the Segment
Standard).

Each “real user” who has access to a segment (i.e. has a segment login
principal) has (in addition to the segment login principal) a segment user
principal, e.g. “guest.User”. The Segment User Principal is required to
assign objects to an Owning User. Each “real user” also has a Principal
Group, e.g. “guest.Group”.

Each segment has a corresponding realm to manage Principals:

- The application login principals are stored in the realm Default.
The segment login principals for segment <segment name> are
stored in the realm <segment name> (e.g. principals for the segment
Standard are stored in the realm Standard).
Each segment has a segment administrator principal (admin-
<segment name>) (e.g. admin-Standard for the segment Standard).
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The following figure shows the situation after the initial setup of openCRX

(assuming you installed openCRX Server or followed the installation guide for
Tomat 6):

Security Realms

LR R R R R LR R R R R R B ]

Default (Login Realm)

Prindpal Groups

Administrators

Root

Prindpal Groups

Administrators

Users

Users

Login Principals

admin-Root

Login Principals
grant acosss o
Segment Root

admin-Foot

(B X RN R E R R R R R R R RN RN RN R R RN R R R R R R R R R RN RN RN NN ]

Standard

Prindpal Groups

Administrators

Unas=signed

Unspecified

Users

Login Principals

grant acosss o
Segment Standard

admin-Foot

Guest

guest | I guest I guest

User Principals

=# admin-Foot. User User Principals
[

I |

| I guest. U=er | I guest.lU=er
1 ( F R E R RN R R R R R EE NN R R R R NN |
Subjects

managed by Root

Figure 1: Security Realms, Principals and Subjects after Initial Setup

Summarizing the above:

e there is a realm for each segment (e.g. a realm Standard corresponding
to the segment Standard)

e the realm Default acts as login realm; it contains all principals who are

allowed to login to the openCRX application; PrincipalGroups in this
realm are only used to configure Granted Roles by inheritance (in

addition to configuring them directly in the appropriate grid).

e there is a subject for each “real user” and all principals of a user are

assigned to the same subject; this allows openCRX to find all principals
of a user (--> role selection drop down)



http://www.opencrx.org/opencrx/2.4/tomcat-6/openCRX_Installation_Tomcat-6.html
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openCRX Admin Guide - Version 2.5.2 Security

The segment administrator (e.g. admin-Standard) creates principals and User
home pages with the operation createUser():

e Each segment login principal has a home page in the corresponding
segment (qualifier of principal and home page must match!).

e Each segment login principal is correlated with a contact. This correlation
is for example required to find all activities and contracts assigned to the
logged in principal.

Realm Standard User Homes Contacts

Principal Groups

Login Principals

grant acoess o
Segment Standard

guest = | LIEST - Guest
User Principals

Realm XYZ User Homes Contacts

Prindpal Groups

Login Principals

grant acoess o
Segment Standard

Uil il
joe = joe =t Joe Doe
User Principals

Figure 2: Segment Administration

managed by Administrator

of Segment XYZ

While each “real user” (typically) has 1 application login principal only, “real
users” may have multiple segment login principals (e.g. because a “real user”
is allowed to access multiple segments or because a “real user” is allowed to
access a particular segment in different roles like Head of Sales or CFO).

Available segment login principals are listed in the so-called Role Drop Down:

Role Drop Down with

Application Login Principal Segment Login Principal(s)

I.guest
guest@Standard  df—

guest@Standard L\}
admin-Standardi@Standard

opencrx

Figure 3: Role Drop Down with list of available Segment Login Principals
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3.1.2 Permissions / Access Control

The openCRX security framework makes a clear distinction between
Ownership Permissions (permissions granted on a particular object) and
Model Permissions (permissions granted on a particular model element). As
the latter are not implemented (yet) we only talk about Ownership Permissions
in this guide.

Ownership permissions are used to control browse/delete/update access to
openCRX objects by Users and UserGroups (i.e. Ownership access control).
Every openCRX object is a SecureObject. The following figure shows an extract
from the UML model (if you are interested in all the details and the formally
correct and complete specifications you should refer to the latest openCRX UML
models):

SecuredbjectHasOwningUser

HFDOLE sacurelibiec e, -
SecureObject - :er..,l.r_DbJa.,t + owningUser . K] User
+ wlists owner © sinng 0..
+ accessLevelBrowse  code
+ accesslevellpdate  code SecureDbjectHasOwningGroup
+* Falal-1 -1 Sre - oo = o Y i i
sccesslevelDelsis © code l, EE.ELEDIJ'!EH . cuningGroup “PrincipalGroup
+ sefOwninglUiser [ ) | ' index . integer | =
+ addOwningGroup | } ; 0.1
= removeCwningGroup [ ) SecureObjectHasGrantingParent
+ removeAlCwningGroup |}
+ sefdocesslovel [ ) + securelbject + faccessGrantedByParent - Al aroots
+ checkPemissions [ . a | ViewCepahle
+ replaceOwningGroup | )
' :
Ll 1
owner[d]: name of Ghject owner Ly Read actess to an object and object creation L
: c
owner1]: name of LN requires sufficient acocess levels granted by the
Storing the owner names in a list allows efficient guernies of acpecclevelBrowse and accecslavellpdate of the
the form “ocwner IE._:IN [<owner name®>, <group names>]. parent object. Typically the access kevels are
accessleval: i retrieved from the direct composite parent. An
0- Nia ; implementation should allow to configure the parent
1 - private T T PP TP, 1 object which grants the acoess (level - 1, leval - 2,
Z - basic (zll usars mamber of primary group) ...J. The reference accessGrantedByFarent points to
3 - deep (all users member of primany growp recursivehy) the parent ohiect used to determine
4 - global accesslevelBrowse and accesslevellpdate.
mede:
0 - lecal
1 - recursive
referenFilter:
list of reference names. If list is empty all composite
referenced objects are processed.

Figure 4: openCRX UML Model - Class Diagram SecureObject

If you see N/P in a reference field instead of a more meaningful
value you probably do not have browse access to the respective
o object (N/P stands for No Permission)

If you see N/A in a reference field instead of a more meaningful
value the object cannot be retrieved (N/A stands for Not Available);

o maybe the object was deleted or the respective provider is not
accessible/available.

The most important security attributes of an object X are discussed below:
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e Owning User: this user "owns" object X; the Owning User can always
browse/delete/update object X (unless the access level is set to 0 [in
which case nobody has access - probably not a desirable situation]).

e Owning Groups: these groups might enjoy privileged treatment for
browsing/deleting/updating object X depending on the relevant access
level settings.

e Access Granted by Parent: this attribute is set by configuration and
refers to the parent object that grants access to object X.

e Browse Access Level: this setting determines which users/user groups
are granted browse access to direct composite objects of object X [i.e.
who can view/inspect direct composite objects of object X (including all
their attributes)].

It is @a common misconception that browse access level of an
object X controls browse access to this object X - please read
Te the above definition carefully!

e Delete Access Level: this setting determines which users/user groups
are granted delete access to object X and all its composite objects
(recursively!) [i.e. who can delete object X and all its composite objects
(recursively!)].

e Update Access Level: this setting determines which users/user groups
are granted update access to object X [i.e. who can change object X; this
includes adding composite objects to object X].

Ganeral | | Charts || Optlons || $ystem
f:ré.rltil‘}"i xrizi@openmdx:org.opencri.kernel. home {1/ provider/C RX/segment/ Standard/userH ome/admin-Standard
:T?r:a ed at: 322008 6:14:34 AM Meodified at: WIH 008 6:49:30 PM
Created by admin-Root Modified by admin-Standard
F;'?ir-; wser: admin-5Standard.User Browse acoess level: [3] deep [group members recursively)
Acrezs granted by parent:  User Homepages| Updsts socoess level [#] basic [group members)
Delete acoess level: [?] basic (group members)
ait Owning Groups
L D Hama = Uisar Group = Disabled = Deecription = Mambsr of Principal Groups = Granted Roles =
i Administrators StandsrdiAdministrators Un=pecifisd

Figure 5: System attributes of an openCRX object as shown in the GUI

The following access levels are available to control which users/user groups
are granted permission to browse/delete/update a particular object X:
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Access Level Meaning

0 - N/A Nno access

1 - private access is granted if the user is owning user of object X

2 - basic access is granted if at least one of the following conditions is
true:

(@) the user is owning user of object X
(b) the user is member of any of the owning groups of object X

(c) any of the owning groups of object X is a subgroup** of
any group the user is member of

3 - deep access is granted if at least one of the following conditions is
true:

(a) the user is owning user of object X
(b) the user is member of any of the owning groups of object X

(c) any of the owning groups of object X is a subgroup** of
any group the user is member of

(d) any of the owning groups of object X is a subgroup** of
any supergroup* of any group the user is member of

4 - global all users are granted access

* 0Owning group Gsyper iS @ supergroup of an owning group G if every user who
is member of G is also member of Gsyper

** Owning group Gey is @ subgroup of an owning group Gif every user who is
member of Geuw is also member of G

3.1.3 The SQL approach to understanding security

If you are familiar with SQL, the following approach to understanding security
might be helpful. Let's put ourselves into the role of the AccessControl Plugin;
accessing an object (read mode) results in a SELECT statement as follows:

SELECT * FROM T WHERE owner IN (p1, p2, ....)

e owner is a column that is present in all (multi-valued) tables
XACCOUNT_, xADDRESS_,, etc.) and it contains a list of principals who
are permitted to access the respective object in read-mode

e theset P = {pl, p2, ...} is calculated by the AccessControl Plugin before
accessing the object and it corresponds to the principals who are
assigned to the current user based on the object's AccessLevel as shown
in the following table:
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Access Level SetP = {p1, p2, ...}
0 - N/A P={}

1 - private P= P

where

P, = {all groups directly assigned to the principal p}
2 - basic P = P, + Pupper

where

P, = {all groups directly assigned to the principal p}

Puper = {all groups that contain at least one group
contained in P,}

3 - deep P = Pp + Pupper + Piower
where
P, =  {all groups directly assigned to the principal p}

Puwper = {all groups that contain at least one group
contained in P,}

Power = {all groups contained in Pypper}

4 - global the where-clause "WHERE owner IN (p1, p2, ....)" is not
required, i.e. the SELECT statement reduces to

SELECT * FROM T

You can mark PrincipalGroups as “Base group” to better control the

n inclusion of PrincipalGroups with Access Level 3.
n

3.2 Activating Security

Security (including Access Control) is not just a fancy add-on, rather it is an
integral part of openCRX; openCRX Access Control is always activated.

The openCRX security provider manages all security data and provides access
control services for all requests through the openCRX API. Hence, you can rely
on openCRX access control even if you write you own clients or adapters for
openCRX.

The only “hardening” you might want to do is the one described in the

" following chapter: set browse access level to 3 for non-Root segments.
n
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3.3 Default Settings

Default access level settings for non-Root segments (e.g. segment Standard)
after a clean install are as follows:

Browse Access Level: 4 - global
Update Access Level: 3 - deep
Delete Access Level: 1 - private

OBJECT_ID = | ACCESS_LEVEL_BROWSE = | ACCESS_LEVEL_UPDATE = | ACCESS_LEWEL DELETE 2
accountz/CR#/Standard 4 3 1
activities/CR*/Standard 4 3
adminz/CR*/Root
buildingz/CR/Standard
codes/CR*/Root
codes/CRx/Standard
contractz/CR#/Standard
depatz/CR#/Standard
docs/CR./Standard
forecastz/CRx./Standard
homes/CR./Standard
miodelz/CR*./Standard
productz/CRE/Standard
uomz/CR*/Root
uoms/CR*./Standard
wiarkflows/CRStandard

Figure 6: Table OOCKE1_SEGMENT after default installation

D | P D] D] D] D] D] D) D) D) P D

oo | | e | | | e | | e | | | e
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Due to the setting access_level _browse = 4 (global) any user with access
to a particular segment is allowed to browse top level objects (i.e. any
user can browse all accounts, all activities, all documents, etc.).

These default settings are suitable for test environments and deployments in
smaller companies/teams with a generous access policy; for most real-world
applications, however, it is more appropriate to set access_level _browse = 3
(deep) for non-Root segments. You can do this by changing the values in the
column access_level_browse from 4 to 3 (table OOCKE1_SEGMENT). After
this change, the table OOCKE1_SEGMENT will look as shown in the following
figure:

OBJECT_ID - | ACCESS_LEVEL BROW/SE2 | ACCESS LEVEL_UPDATE = | ACCESS _LEVEL DELETE 2 |

accountz/CR¥AStandard 3 K] 1
activities/CHx/Standard 3 3 1
adminz/CRx/Foot

Figure 7: Table OOCKE1_SEGMENT after modification

Segment security settings are loaded during the initialization of the
openCRX servlet. Hence, if you change settings you must redeploy

Imporiant o henCRX for the new settings to become active.




openCRX Admin Guide - Version 2.5.2 Security

3.4 Security Settings of New Objects

New objects are by default created with the following security settings:

Browse Access Level: 3 - deep
Update Access Level: 2 - basic
Delete Access Level: 2 - basic

Access Granted by Parent in general: Parent object as modeled

exceptions: there are some select exceptions, but
they are all pre-configured

Owning User: User who is creating the object

Owning Groups: Primary User Group of the user who is
creating the object and (meaning as well as)
Owning Group(s) of the parent object of the
new object (except Users, see below).

Please note that the User Group Users (e.g. Standard\\Users) is not
added to the list of Owning Groups of newly created objects unless
Imporiant  +he creating user's Primary User Group is equal to Users.

By default, a user's primary user group is <user>.Group. This group
is created automatically when the segment administrator runs the
wizard User Settings from a user's homepage (see chapter 4.1
Creating Users).

Imporiant

Please note that a User's Primary User Group can be set by the
segment administrator with the operation Create User . To change an

Imporiant  oyisting user's primary group, the segment administrator simply
executes the operation Create User again with a new parameter for
primary user group.

In the context of activity management there are various operations
that set/change the Owning Groups of objects based on the settings

o of an assigned Activity Creator or assigned Activity Group and not
based on the settings of the user who executes the operation.
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3.5 Checking Permissions

You can check security permissions on any SecureObject with the operation
Security > Check Permissions. Provide the principal name as a parameter. The
following figure shows the result of the operation on a user's homeage:

My Homepage | Accounts Activities Pipeline w» |
! fit User Homepages - Guest, Joe O - My Homepage

File Edit Find View Actions Security Wizards

Has read permission:
Has update permission:
Has delete permission:
Mermbership for read: *

Membership for update:  Standard:guest.User
Standardiguest

Membership for delete: Standardiguest.User
Standard:guest

Figure 8: Result of Check Permissions

The meaning of the above result is as follows:

Has read permission: principal can browse this object
[] principal cannot browse this object
Has update permission: principal can modify/update this object
[] principal cannot modify/update this object
Has delete permission: principal can delete this object
[] principal cannot delete this object
Membership for read: principal has read permission if the intersection of

the resulting list of groups and the list of owning
groups of the respective SecureObject is not
empty

Membership for update: principal has modify/update permission if the
intersection of the resulting list of groups and the
list of owning groups of the respective
SecureObject is not empty

Membership for delete: principal has delete permission if the intersection
of the resulting list of groups and the list of
owning groups of the respective SecureObject is
not empty
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3.6 Login Procedure

The openCRX login procedure consists of 2 levels:

3.6.1 Apache Tomcat / Application Server Login

The Apache Tomcat / application server login procedure depends on various
parameters:

e Servlet container (Apache Tomcat, JBoss, BEA WLS, IBM WAS, etc.)
e configuration of Apache Tomcat / application server

file-based realm (e.g. tomcat-users.xml for Tomcat)

DB-based realm (e.g. JDBCRealm Tomcat)

LDAP-based realm (e.g. JNDIRealm for Tomcat; see also chapter 15.2
Tomcat w/ openCRX and LDAP-based Authentication)

company-specific / custom-tailored realms

Please note that even though openCRX might be involved in managing some of
the above-mentioned realms (e.g. DB-based realm) the login procedure is not
really under control of openCRX. Many login problems are really related to
incomplete/faulty configuration settings of the servlet container.

Detailed documentation about the many Realms supported by Apache
Tomcat is available at
Tio http://tomcat.apache.org/tomcat-6.0-doc/realm-howto.html

3.6.2 Segment Login

Access to segments is managed/controlled by the ObjectInspectorServiet. The
included DefaultRoleMapper identifies all Segment Login Principals of a given
Subject and grants access to the respective segments through the Role Drop
Down:

Role Drop Down with

Application Login Principal Segment Login Principal(s)

.’guest
guest@Standard  dfe—

guesti@Standard %
admin-Standardi@Standard

Figure 9: Role Drop Down with list of available Segment Login Principals

opencrx

It is possible to deploy user-specific implementations of the DefaultRoleMapper
so that you can adapt the segment login procedure to your requirements.
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3.6.3 Disabling Login

Please refer to the chapter “"Disable/Deactivate Users”.

3.7 Resetting Security

If you get the setting of Update Access Level wrong you may not be
) able to change the respective object from the GUI anymore (and that
Waminu  includes the security settings of that object!). For example, the only
way to recover from setting Update Access Level to 0 - N/A for a
particular object is to edit the data directly in the database!

It is simply not possible to disable openCRX Security.

If you (or one of your users) managed to screw up the security settings in a
major way you might be forced to reset all security settings to a well-defined
state. Not an easy task — and it typically involves a lot of manual work.

Educate your users about openCRX security. You might also consider
disabling some of the more powerful operations and/or security
fm attributes in the default GUI.
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4 Managing Users

Read through the chapter Basic Concepts and Conventions (Security)
before reading this chapter. It is quite helpful to have a good

Tin understanding of the terms Subject, Application Login Principal,
Segment Login Principal, User, etc. before you start reading here.

4.1 Creating Users

Even though you can create users with a variety of methods, “behind the
scenes” the following steps are always required to create a new openCRX user:

Who Steps
Root administrator e create a new Subject
admin-Root - set the qualifier to the desired login id

e create a new Principal in the realm Default
(--> Application Login Principal)
- set the qualifier to the desired login id

link this Principal to the Subject created
in the previous step

make this Principal member of the
appropriate Principal Group(s), e.g.
Users

Segment administrator e create a new Contact

admin-<SegmentName>
e create a new User

link this new User to the Contact
created in the previous step

the Segment Login Principal is created
automatically

the userhome is created automatically

e run the wizard Edit > User Settings from
the new user's homepage

Depending on how you create a new user, some of the above steps might be
taken care of by a wizard. If you want to have full control over the user
creation process, however, then you can certainly create new users following
the above instructions step by step.

Have a look at Figure 1: Security Realms, Principals and Subjects after Initial
Setup and Figure 2: Segment Administration to see how this all fits together.
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4.1.1 Create Users as Segment Administrator

The Segment administrator can create new users with the following steps:
e login as Segment administrator (e.g. admin-Standard)
e create a contact for the new user

e Click on the (potentially hidden) tab [User Homepages]:

Home | Accounts  Activities Pipeline Products Depots Folders & Documents
B Accounts

File Edit WView Actions Security Wizards Reports

Accounts || Account Groups | Competitors | Organizations
Ly 2 Mew Edit View
I D Full name = Alias name ~ Phone business Phone mobile E-mail business -

Figure 10: New user guest — step 1

« Next you select the operation Actions > Create User... which allows
you to create and initialize a new user:

Home Accounts Activities Pipeline Products Depots Folders & Documents »
, &} User Homepages

Edit View Actions Security
Create User...
Imiport Us
Update Index...

User Homes

L
Figure 11: New user guest — step 2

'l.l' I W

« Type the new user's principal name (e.g. guest) into the field Principal
name, use the Lookup Inspector or the auto-completer to fetch values
for Contact and Primary user group (note that you must either fetch
values with the Lookup Inspector or select entries from the auto-
completer's drop down menu for the parameters Contact and Primary
user group, i.e. it is not sufficient to just type some text into these
fields), and then type a password (e.g. opencrx) into the fields Initial _
password and Password again:

Create User b
Principal name: guest
Contact: guest, [guest,] -,
Primary user group: Users [Users] 4
Initial password: Ty
Password again: TTTTTY]

T

Figure 12: New user guest — step 3
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Status O indicates that the user guest was created without errors:
|

Home Accounts Activities Pipeline Products Depots Folders & Documents  w»

, & User Homepages

Edit Wiew Actions Security

Status: 0
Status message:
Created UserHome: guest, [Edit]

Figure 13: New user guest — step 4

Next we navigate to the homepage of the newly created user guest by
clicking on the icon as show below:

.
Home Accounts Activities Pipeline Products Depots Folders & Documents  »
, i User Homepages
Edit VWiew Actions Security
User Homes
o N View
Frimary User Group — E-mail subject prefix = Web access URL ~ Store settings on logoff —

-2

I |:| Contact =

admin- L R .
i - Administrators [CR: Standard)
Standard,

- B

Figure 14: New user guest - step 4

Please note that we are still logged in as admin-Standard (as shown in
the header of the application), but we are looking at the homepage of
the user guest. Execute the operation Edit > User Settings:

admin-5tandard@Standard Logoff admin-Standard

Sawve Settings

opencrx

en_U5

Home Accounts Activities Pipeline Products Depots Folders & Documents  »
2} User Homepages = guest, - Home

File Edit Find View Actions Security Wizards

Ediit
Gener‘ User Settings.. !ans System

Contach: guest,

Figure 15: New user guest — step 5
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This will start the wizard User Settings. You can configure various
settings with this wizard. At a minimum you should probably set the
timezone and enter the new user's e-mail address. Once you're done
you can click the button [Apply]. The wizard will then create a bunch of
objects and finalize the initialization of the user guest:

7 ]
& openCRX - User Settings - Mozilla Firefox Mi=[<
File Edit \iew History Bookmarks Tools Help
- c ot | http: /localhost: 28080 jopencrx-core-CRX fwizards jen_USUserSe3d%. .7 -
opencrx
User Home Activities
Timezone:| EuropeZurich V Private activity tradker:  guest-Private
Store Resource: \guest,
settings on |:|
logaoff: Subscriptions
Email: guesti@company.com MNaotify on
Sendmail Is Active Creation Replacement Remowval
subject [CRX: Standard] Account
prefix: Madifications: |:| |:| |:| |:|
Web Activity
BCOSSS http://localhost: 8080/ openone-core-CRX Follow Up |:| |:| |:| |:|
LIRL: Modifications:
Activity |:|
Root Menu Modifications: I:l |:| |:|
Is Active:
Accounts: reduct
P . Medifications: |:| |:| |:| |:|
Activities: Cuote
Modifications: I:l D I:l I:l
o SalesOrder
Show max itemns in top - Medifications: I:l I:l I:l I:l
navigation: =
Apply Cancel
Done & N2 & noce

Figure 16: New user guest — step 6
e Click [Cancel] to leave the wizard.

The wizard User Settings creates a user group <username>.Group,
in the above case guest.Group. The primary user group of the user

Tin guest was automatically set to this new user group guest.Group.

If you want to change the primary user group to anything else or if
you ever must reset a user (lost password, etc.), you can re-execute
the operation Create User as admin-Standard at any time.

If you want to reset a user without changing the user's password, you
can simply leave the password fields empty when recreating the user.
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4.1.2 Import Subjects and Application Login Principals

Creating large numbers of subjects/principals by hand can be quite a tedious
job. If you prepare a text file containing the appropriate information in the file
format as outlined below, the Root administrator (admin-Root) can use the
operation Actions > Import Login Principals to create Subjects and Application
Login Principals automatically.

OpenCI‘X Z:HERM@RM Root

Administration | UOMs Codes  Security Realm  Security Policies  Security Subjects

, ™o Administration

Edit View Actions Wizards

. . Create Administrator. ..
Configuration| ;o0 | ogin Principals. .
L7 ] Q, New Edit View
M [] Hame = Description =

Figure 17: Operation Actions > Import Login Principals (admin-Root)

Listing 1: File Format Subjects and Application Login Principals

Subject;<subject name>;<subject description>

Principal;<principal name>;<principal description>;<subject name>;<groups>

Listing 2: Example File Subjects and Application Login Principals

Subject; joe;Doe, Joe

Subject;mark;Ferguson, Mark
Subject;peter;Lagerfeld, Peter

Principal; joe;Doe, Joe;joe;Users,Administrators
Principal;mark;Ferguson, Mark;mark;Users
Principal;peter;Lagerfeld, Peter;peter;Users
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4.1.3 Import Users

Similarly to importing Subjects and Application Login Principals from a file you
can also import Users from a file. If you prepare a text file containing the
appropriate information in the file format as outlined below, the Segment
administrator (admin-<SegmentName>) can use the operation Actions >
Import Users to create Users automatically.

My Homepage Accounts Activities Pipeline Products Depots Folders & Documents  »
. it User Homepages

Edit View Actions Security

Create User...
User Homes Import Users

M Update Index... View

Figure 18: Operation Actions > Import Users (admin-Standard)

Listing 3: File Format Users

User;<principal>;<account alias>;<account full name>;<primary group>;<password>[;group [, group] ]

Parameter Description

<principal> required, name of principal

<account alias> at least one value per user must be provided, i.e. either the alias name

<account full name> of the contact, or then the full name

<primary group> optional, default is <principal>.Group
<password> required, clear text value
group optional, the user is made a member of each provided principal group

Please note that a “-” value (a dash without the quotes) means empty in the
context of a user file. Example: if you don't want to explicitly define a primary
group, you can just put a dash and the importer will create the default primary
group <principal>.Group for the respective user.

Listing 4: Example File Users
User;joe;JD;Doe, Joe;Users;2%j0d.IT;MGMT,SALES

User;mark;Fergi;Ferguson, Mark;Users;maFeé&.3-;MGMT
User;peter;-;Lagerfeld, Peter;-;PlF*;ReGal;SALES

Contacts are not created automatically; existing Contacts are first
searched by <account alias>. If no matching account alias is found,
Contacts are search by <account full name>. If still no matching
account is found, the UserHome is not created.

Important

Users are only imported/created if the referenced Principals exist.
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4.2 Disable/Deactivate Users

There are various ways of disabling/deactivating users. To fully understand
your options it is helpful if you are familiar with the openCRX Login Procedure.

4.2.1 Disable Users at the level Tomcat /Application Server

Depending on the configuration of your application server you can disable
users at that level. For example, if you rely on file-based realms, you can
simply remove users from the file tomcat-users.xml (with Apache Tomcat) or
users.properties (with JBoss) to prevent access to openCRX. If you block
access at the level Tomcat / application server such users are locked out from
accessing any application and any openCRX segment. However, as the Tomcat/
application server Login procedure is not entirely controlled by openCRX you
might have to consult the documentation of your respective application server
or ask your application server administrator for details.

4.2.2 Disable Users at the level openCRX

The segment administrator (e.g. admin-Standard) can prevent a user from
accessing a particular openCRX segment by either disabling the respective
Segment Login Principal or by deleting it altogether. Disabling is the preferred
option to prevent access temporarily. If a user has multiple Segment Login
Principals you must disable all of them to prevent access to the openCRX
application.

5]
B guest - Principal

dit View

facpriy Realms ® fandard * goesi

General ||Systam F|

Name: guest ' Disabled: l

Subject: guest EECTILre Standardiiguest
Last kogin at: 121306 11:45 AM

Figure 19: Disabling of Segment Login Principal guest by admin-Standard

You should not delete a particular Subject as long as it is referenced
by any Principal. Otherwise you'll end up with “dangling” Subject

Importamt - forences.
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Deployment Scenarios

5 Deployment Scenarios

openCRX supports a multitude of deployment scenarios.

5.1 Typical Deployment Scenarios

The following table lists some of the pros and cons of the most common
openCRX deployment scenarios. Please note that the list is by no means

complete:

3-Tier with Tomcat/OpenEJB

» Tomcat engine extended by
openElB (lightweight EJB 3.0
implementation) so that EARs
with EJBs and WARs can be
deployed

» simple setup and management
(Server Installer)

* limited scalability and availability
(no clustering)

= highest performing 3-Tier
deployment with full
transaction service

Tomcat/OpenEJB*

Browser openCRX/core EAR

openCRX
GUI
(Serviet)

openMDX

openCRX
Provider

[iata bass

Figure 20: 3-Tier with Apache Tomcat / OpenEJB

4-Tier with Tomcat/OpenEJB

» Multiple Tomcat engines
extended by OpenEJB and
fronted by load balancer
(subsequent session requests
are sent to the same Tomcat
instance)

» database cluster
» good scalability and availability

= high performance 4-Tier
deployment with full
transaction service

http/https
Load Balancer®

Multiple Instances
Tomcat/OpenElB

openC A/conr= EAR

Browser

3-Tier with AppServer

= J2EE-compliant Application
Server (JBoss is supported
out of the box)

» Simple setup and management
(one application server)

* limited scalability and availability
(no clustering)

* Transaction Service

Application Server

Browser

openCRX/core EAR

openCRX
GUI
(Servlet)

openCRX
Provider

openiDX

Database

Figure 22: 3-Tier with J2EE-compliant Application Server
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4-Tier with Clusters

= demanding setup (four and
more application servers)

= multiple security zones for
highest security (Internet,
DMZ, Intranet)

= maximum availability
= fully fault tolerant

= unlimited scalability
» Transaction Service

Servlet Engine(s) /
Application Server(s)

Browser
N openCRX/core EAR

openCRX
Ul
(Serviat)

Internet O Z

Application Server(s)
openCRX/core EAR

openCRX
P rowider

Intranat

Figure 23: 4-Tier with Clustered Application and DB Servers
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5.2 Multi Entity Deployment Scenarios

The open source MDA platform openMDX supports a multitude of deployment
scenarios and persistency configurations. The most common multi entity
deployment scenarios are discussed in the following sections.

5.2.1 Multiple Data Segments in a single DB

The setup “Multiple Data Segments in a single DB” provides adequate security
for many use cases and is relatively easy to manage. As all the data is stored
in a single database, however, security configuration mistakes (e.g. principals
linked to the wrong subject, etc.) might lead to situations where a user is
granted access to the data of a particular company/client that should not be
accessible (please note that human error is the real root cause here, not a
malfunction of openCRX). Furthermore, this setup is not recommended if users
can get direct access to the database, e.g. with third party reporting tools as
those tools typically bypass the openCRX API.

Data
Segment
Company #1

Data
Segment
Company #2

Data
Segment
Company #N

SR

B OOCKE1_ACCESSHISTORY

B OOCKE1_ACCESSHISTORY_

B 00CKE1_ACCOUNT

B OOCKET_ACCOUNT_

B OOCKE1_ACCOUNTASSIGNMENT

B OOCKE1_ACCOUNTASSIGMMENT_

B OOCKET1_ACTIMITY

B DOCKE1_ACTIMITY.

B OOCKE1_ACTIMITYCREATOR

B OOCKET1_ACTIMITYCREATOR_

B 00CKE1_ACTMITYEFFORTESTI

B OOCKE1_ACTMITYEFFORTESTI_

BH OOCKE1_ACTRATYFOLLOWUPR

B OOCKET_ACTITYFOLLOWUPR_

B OOCKET1_ACTIATYGROUP
HﬂKE1_ﬁCTIVITYGHDUP_

Figure 24: Multiple Data Segments in a single DB

Detailed instructions on how you can create and configure new segments are
provided in the installation guide for Tomat 6.
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5.2.2 Multiple DBs

The highest level of security is provided by setting up a dedicated database for
each entity so that data sets of the various entities are physically separated:

Database Database

Company #1 Company #1
- I —
B O0CKE1_ACCESSHISTORY B OOCKET_ACCESSHISTORY
B O0CKE1_ACCESSHISTORY_ B OOCKE1_ACCESSHISTORY_
B OOCKE1_ACCOUNT B O0CKE1_ACCOLMT
B O0OCKE1_ACCOUMT_ B OOCKET_ACCOUMNT_
B OOCKE1_ACCOUNTASSIGHNMENT B O0CKET_ACCOUNTASSIGHMENT
B OOCKET_ACCOUNTASSIGMMENT_ B OOCKET_ACCOUNTASSIGMMENT_
B OOCKE1_ACTIMITY B OOCKET_ACTIMITY
B OOCKE1_ACTIITY_ B O0CKE1_ACTIVITY.
B O0CKE1_ACTITYCREATOR B OOCKET1_ACTIVMITYCREATOR
B OO0CKE1_ACTWITYCREATOR_ B OOCKET_ACTIMITYCREATOR_
B OOCKE1_ACTIVITYEFFORTESTI B O0CKET_ACTIITYEFFORTESTI
B O0CKE1_ACTIWITYEFFORTESTI_ B OOCKET_ACTIMITYEFFORTESTI
B OOCKE1_ACTIVITYFOLLOWUR B O0CKET_ACTIITYFOLLOWLP
B OOCKET1_ACTIMITYFOLLOW LR B OOCKET_ACTITYFOLLOWUP_
B O0CKE1_ACTMTYGROUP B OOCKE1_ACTIATYGROUP
B DOCEE1_ACTIMITYGROUP_ B DOCKE1_ACTIVITYGROUP
— T —

Figure 25: Dedicated DB for each Entity

5.3 openCRX Custom Applications

Information about openCRX custom projects is available from the openCRX

wiki, e.g.

https://sourceforge.net/apps/trac/opencrx/wiki/Sdk24.CustomProject.
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6 Workflow Controller

With the Workflow Controller the openCRX Root administrator (admin-Root)

can enable/disable various servlets (configured in web.xml) included in the

openCRX distribution. This chapter gives an overview over the currently

available servlets and explains how to start/stop them.

You can access the Workflow Controller by navigating to the URL
http://127.0.0.1:8080/opencrx-core-CRX/WorkflowController

or starting the Workflow Controller Wizard as shown in the figure below:

OpenCI‘X admin-Root@Root Root

en LS

Administration | UOMs Codes  Security Realm  Security Policies  Security Subjects

,| E2 Administration

Edit View Actions Wizards
openCRX Workflow Cnntrullﬁ:r..ﬂ

Configurations openCRX Log Console...

Figure 26: Accessing the openCRX Workflow Controller

You should connect to the Workflow Controller with http. If you
use SSL-secured connections to start/stop servlets you must ensure
that your server's certificate is available in cacerts.

The following figure shows the Workflow Controller of openCRX 2.5.2:
\& Mozilla Firefox 3 Beta 3

File Edit WView History Bookmarks Tools Help '

& - @ “Y ", http:/f127.0.0.1:8080 opencrx-core-CRY WorkflowController
., http:/[127.0.0.1:...rkflowController [_J

openCRX Workflow Controller

SubscriptionHandler/execute Tprovider=CRE & segment=Standard Turn On
WorlflowHandler/executePprovider=CEX & segment=S8tandard  Tum On

IndexerServiet/execute Tprovider=CEX & segment=5tandard Turn On

Figure 27: openCRX 2.5.2 Workflow Controller

Please note that access is granted to the openCRX Root administrator
(admin-Root) only. Hence, if you see the openCRX login screen

o instead of the Workflow Controller you must first login as Root
administrator. Also, ensure that openCRX is properly initialized before
you connect to the Workflow Controller.
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The first time the Workflow Controller is started it will create a default

configuration:
Tin

¢ WorkflowController - Component Configuration X

Edit View Security

General | System =

Mame: WorkflowController
Dezcription:

o, Mew Edit View
I D Name = Description = Domain = Date value = 5tring value =
ab  serverlRL Server URL http:/127.0.0.-

lopencrx-core

SubzcriptionHandler

ab SubscriptionHandler. CRX_Standard. autostart falze
autostart

ab SubscriptionHandler. CRX.Standard. pingrate 5.” bscriptionHandier 2
pingrate

ab IndexerServiet. CRX. Standard. autostart indexerservict falze
autostart

ab Indexerzerviet. CRX Standard. pingrate In.d Exerservist 2
pingrate
"

ah WorkflowHandler.CRX. Standard . autoztart WorkflowHandler falze
autostart
"

ab WorkflowHandler.CRX . Standard. pingrate WorkflowHandler 2

pingrate

Figure 28: Default Configuration of WorkflowController

If you ever need to recreate this default configuration, you can do so
with the following steps:
e stop the WorkflowController

e delete the Configuration with the name WorkflowController

e start the WorkflowController

You can manually start (stop) servlets that are managed by the Workflow
Controller by clicking on “Turn On” (“Turn Off”). Please note that you can
control servlets on a segment by segment basis. For example, if you created a
segment “"OtherSegment” in addition to the segment “Standard” you can
start/stop servlets of the segment “"OtherSegment” without interfering with the
servlets of the segment “Standard”.
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6.1 Workflow Controller Configuration

In addition to configuring the Startup option of the Workflow Controller you
can also configure various options related to the servlets managed by the
Workflow Controller. The configuration of the Workflow Controller is available
to the openCRX Root administrator (admin-Root) by navigating to
Administration and then clicking on the icon of the WorkflowController:

“ | Administration

~ Administration

Edit View  Actions Wizards

= -

=

= L

88 Codes Configurations

Ffl Security Realm Wl 3, Mew Edit View
5 security Policies bl ] —

.

& o ¢ Waorkflow Controlier

Figure .29: openCRX Administration — WorkflowController

6.1.1 Startup Configuration in web.xml
You can start the Workflow Controller manually by navigating to the URL
http://127.0.0.1:8080/opencrx-core-CRX/WorkflowController

or starting the Workflow Controller Wizard. However, it is also possible to start
the Workflow Controller automatically by activating the corresponding option
in the file web.xml:

Listing 5: web.xml - auto startup of the Workflow Controller

<!-- WorkflowController -->

<servlet id="WorkflowController">
<servlet-name>WorkflowController</servlet-name>
<servlet-class>org.opencrx.kernel.workflow.servlet.WorkflowControllerServlet</servlet-class>

<!-- activate if WorkflowController should be initialized at startup-->

<load-on-startup>10</load-on-startup>
</servlet>

With the value of load-on-startup (10 above) you can control the

order of starting up servlets in case there is more than one servlet.
Tin
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6.1.2 ServerURL

Adapt the value of serverURL to your environment (e.g.
http://127.0.0.1:8080/0opencrx-core-CRX):

<+ WorkflowController - Component Configuration
Edit  View

Administration = WorkflowController

General System) *

Mame: WorkflowController
Description:
Properties
Mew  Edit
? O B E N E
It * Hame = String value
[]

lah senverlJRL http:.-'.-'12?.III.III.1:BIIIEIII.-'-::pencrx-c-:ure-CR'f]
a waorktlowHandler. ~standard. pingrate il

Figure 30: Workflow Controller Configuration — serverURL

6.1.3 Handler pingrate and autostart

Use pingrate to define the interval (in minutes) between successive calls of
the respective handler and autostart (true/false) to start the respective
handler automatically:

¢« WorkflowController - Component Configuration

Edit View
Administration = WorkflowController
General Systemn) *
Mame: WorkflowController
Description:
Properties

Mew  Edit

I+ * Hame - String value

]
[ah SubscriptionHandler. CRX. Standard.pingrate 1 ]

ab SubscriptionHandler. CRX Standard. autostart true

Figure 31: Workflow Controller Configuration — pingrate and autostart
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6.2 Serviet IndexerServilet

The openCRX IndexerServlet updates index entries (used for keyword/index
based search introduced with openCRX v2) by indexing all objects which do not
have an IndexEntry newer than the modification date of the object. The
IndexerServlet creates an index by invoking the operation updatelndex() on
the object to be indexed.

Please note that indexing can put some heavy load on your database

server. Hence, you might consider turning off (or at least lowering the
T frequency of calling) the IndexerServlet during busy hours.

If you are looking for a way to define advanced schedules for calling

the openCRX indexer you might consider cURL in combination with a

scheduler provided by your operating system (e.g. Scheduled Tasks

on Windows, cron on Linux).

With curl calling the indexer boils down to calling curl with the

appropriate URL as a parameter. The following example shows how to

call the indexer for the provider CRX and the segment Standard:

curl "http://localhost:8080/opencrx-core-CRX/IndexerServlet/execute?
provider=CRX&segment=Standard"

6.3 Serviet SubscriptionHandler

The openCRX SubscriptionHandler is the backbone of the openCRX Subscribe /
Notify Services. The Subscription Handler does not require any configuration
by the openCRX administrator other than setting the pingrate and autostart
options, i.e. it is designed to work “out of the box”.

Turning on the SubscriptionHandler of a particular segment is required if you
want that segment to provide Alerts and E-mail Notifications to its Users.
The polling frequency can be set by the Root administrator (see Figure 31:
Workflow Controller Configuration — pingrate and autostart).

The SubscriptionHandler checks openCRX audit entries on a regular basis and
- if matching Subscriptions exist — executes the Workflow Process referenced
by the Subscription using Userhome.executeWorkflow().

Userhome.executeWorkflow() — implemented by the openCRX plugin - creates
an entry in Userhome.wfProcessInstance (accessible through the grid Workflow
Process Instances). Synchronous workflows are executed immediately,
asynchronous workflows are left alone (the Servlet WorkflowHandler is
specialized in dealing with asynchronous workflows — see below for details).



http://localhost:8080/opencrx-core-CRX/IndexerServlet/execute?provider=CRX&segment=Standard
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6.4 Serviet WorkflowHandler

The openCRX WorkflowHandler is responsible for executing WfProcesslnstances
based on asynchronous WfProcesses like:

e org.opencrx.mail.workflow.ExportMailWorkflow

e org.opencrx.mail.workflow.SendMailNotificationWorkflow

e org.opencrx.mail.workflow.SendMailWorkflow
The execution frequency can be set by the Root administrator (see Figure 31:
Workflow Controller Configuration — pingrate and autostart).

Please note that the WorkflowHandler is required for outbound E-Mail

Services.
Tin

The WorkflowHandler executes Workflow Process Instances that have not been
executed yet.

The first time the WorkflowHandler is started it will create various

default Workflow Processes:
Tin

w Workflows

Edit View  Actions Security

Workflow Processes | Topics

H =4 New  Edit View

L |:| Mame & Pricrity = Is synchronous =
= org.opencrx.kernel. workflow . PrintConzole 0 v

=+ org.opencrx. kernel. workflow SendAalert 0 v

i org.opencrx.mail. workflow ExportMailVorkflow 0

= org.opencrd.mail. workflow . SendMailMotificationVWorkflow 0

= org.opencr<.mail workflow . SendMailVorkflow 0

Figure 32: Default Workflow Processes created by WorkflowHandler

If you ever need to recreate these default Workflow Processes, you
can do so with the following steps:
e stop the Servlet WorkflowHandler

e delete the Workflow Processes that were originally created by
the WorkflowHandler (or at least the ones that still exist)

e start the Servlet WorkflowHandler

All WfProcesses with undefined/unknown runtime length should be
defined as asynchronous. This is particularly true for WfProcesses that

Wperta might block. The default setup ensures that blocking WfProcesses
cannot block openCRX.
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6.5 Trouble Shooting Serviets

All the openCRX servlets controlled by the Workflow Controller log their actions
to the server log file (e.g. TOMCAT_HOME\log\catalina.<date>.log). The
following log file extract shows, for example, that the three Servlets Indexer-
Servlet, SubscriptionHandler, and WorkflowHandler seem to be working fine:

Listing 6: Servlets managed by Workflow Controller log to server.log
20:25:18,388 INFO [STDOUT] Tue Mar 04 20:25:18 CET 2008: Indexer CRX/Standard

20:27:18,400 INFO [STDOUT] Tue Mar 04 20:27:18 CET 2008: SubscriptionHandler CRX/Standard
20:27:18,400 INFO [STDOUT] Tue Mar 04 20:27:18 CET 2008: WorkflowHandler CRX/Standard

openCRX Exceptions (like NullPointers, etc.), however, are still logged to the
application log file as configured during the installation.

It is always worth checking whether the Workflow Handlers actually are active;
they must be started by the Root administrator. You can find out by connecting
to the Workflow Controller (see Figure 27: openCRX 2.5.2 Workflow
Controller).

After restarting the application server all servlets managed by the
WorkflowController are inactive, i.e. the Root Administrator must
explicitly turn them on again (if desired) unless the respective
servlet's autostart option is set to true in the WorkflowController's
configuration and the WorkflowController's Startup option is set to
true in the file web.xml. The servlets do not automatically resume
the state they were in before the application server was shut down.
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Subscribe / Notify Services

7 Subscribe / Notify Services

openCRX features a powerful event subscription and notification service:
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Figure 33: Event and Notification Service

Once a topic is created, openCRX users can subscribe to it. Users manage their
subscriptions individually on their UserHomes (with the Wizard UserSettings or
by editing their subscriptions manually). If a topic has subscribed users and a
monitored event occurs then the predefined actions are performed. If the
action is set to - for example - creating an alert for subscribed users, then
each subscribed user will receive an alert on the UserHome.

Please note that event and notification services depend on the Servlet
SubscriptionHandler, i.e. you must turn on the openCRX

Subscription Handler for the respective segment with the Workflow

Controller, otherwise Topic Actions are not executed, i.e. no Alerts will
be created and E-mail Notifications will not be delivered.
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Furthermore, as outbound E-Mail Services depend on the
WorkflowHandler, you must activate the Workflow Handler to receive
Imporiant  E_Mail Notifications.

The openCRX distribution includes quite a few default topics (see Figure 34:
Standard Topics included in the openCRX distribution) to get you started:

e Topic Account modification alert sends an alert to the UserHome of
subscribed users whenever an account is modified.

e Topic Activity follow-up modification alert sends an alert to the
UserHome of subscribed users whenever a Follow Up of an Activity is
modified.

e Topic Mail notification for new alerts sends an e-mail notification to
subscribed users — assuming outbound e-mail services are configured
correctly — whenever an Alert is created/modified.

Please note that newly created Segments do neither contain Workflow
Processes nor Topics (i.e. the respective grids are empty). Both
Workflow Processes and Topics can be created by the segment
administrator with the wizard Segment Setup.

Imporiant

| Workflow Processes Topics

H =N New  Edit View

L D Hame & Actions to perform =

L Account modification alert org.opencrx kernel workflow . SendAlert
- Activity follow-up modification alert org.opencrx kernel workflow . SendAlert
= Activity modification alert org.opencr< kernel workflow . SendAlert
L | Booking modification alert org.opencrx kernel workflow . SendAlert
L Competitor modification alert org.opencr<.kernel workflow. SendAlert
- Compound booking modification alert  org.opencrs kernel workflow . SendAlert
. Inwoice modification alert org.cpencrx. kernel workflow SendAlert
= Lead modification alert org.opencrx kernel workflow . SendAlert
= Mail notification for new alerts org.cpencrx.mail workflow . SendMaillotificationWork flow
b4 Opportunity modification alert org.opencrx kernel workflow . SendAlert
= Organization medification alert org.cpencrx. kernel workflow SendAlert
- Product modification alert org.opencr< kernel workflow . SendAlert
= Quote modification alert org.opencrx kernel workflow . SendAlert
= Sales order modification alert org.opencr< kernel workflow . SendAlert

Figure 34: Standard Topics included in the openCRX distribution

Users can easily custom-tailor their subscriptions with filters and by selecting
event types like Object Creation, Object Replacement, and Object Removal.
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7.1 Example Subscription — Account Modifications

In this example we will create a subscription to the standard Topic Account
Modifications for the user “guest”.

e Login as guest, and execute the operation Edit > User Settings to start
the respective wizard. Check both “Is Active” and “Creation” as shown

below:

Activities
Private activity tracker: guest~Private
Resource: guest,

Subs=criptions

Motify on
l= Active Creation Replacement Removal

Account modification alert: vl IF] [Fi
Activity tollow-up modification
alert: D D D D

Activity modification alert: IF] IF] IF] [Fi
Figure 35: Create a new Subscription

e Click Apply to store your settings.

Please note that the Root administrator must start the Subscription

Handler — otherwise you will not get any Alerts/Notifications.
Important

7.2 Example Subscription — Activity Assignment Changes

With the following steps you can create a subscription to activity assignment
changes:

e nhavigate to your Userhome and create a new Subscription
e populate the fields as follows:

Name: Activities assigned to me
Description: (any description you like)
Active: checked

Event type: (leave empty)

Topic: select Activity Modifications

Name of filter #0: assignedTo
Value of filter #0: copy the Identity of the respective user's homepage

e save your subscription

To locate the identity of a user's homepage, you can navigate to the respective
homepage and inspect the tab [System]. The pattern is as follows:

xri://@openmdx*org.opencrx.kernel.homel/provider/<providerName>/segment/<SegmentName>/userHome/<principal>

€.J. xri://@openmdx*org.opencrx.kernel.homel/provider/CRX/segment/Standard/userHome/guest
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7.3 Example Subscription with Filtering

In combination with openCRX security the subscription filter feature enables
you to provide highly specific subscriptions. Imagine the following situation:
there are 2 Activity Trackers DivisionA:ProjectX and DivisionA:ProjectY
and some of your users are interested in receiving notifications related to
activities of ProjectX only, whereas some users want to receive notifications
related to activities of ProjectY only. A third group of users wants to receive
notifications from both projects. Such a situation could be handled as follows:

e create a PrincipalGroups DivisionA.ProjectX and DivisionA.ProjectY

e assign PrincipalGroup DivisionA.ProjectX to ActivityTracker
DivisionA:ProjectX; like this new activities assigned to this Tracker will
also be assigned the PrincipalGroup DivisionA.ProjectX

e assign PrincipalGroup DivisionA.ProjectY to ActivityTracker
DivisionA:ProjectY; like this new activities assigned to this Tracker will
also be assigned the PrincipalGroup DivisionA.ProjectY

e an Activity Modification subscription of a user wanting notifications
related to ProjectX and ProjectY would look as follows:

Activity modification alert - Subscription

Gansral

Mame: Activity modification alert Active:
Drescription: Project’ only Event types: =
Topic: Activity modification alert %

FEwn

MName of filter #]: Value of filter #0: Standard:Divisiond.Projectl =

oWner Standard:DivisionA.ProjectB

Figure 36: Create a Subscription with Filters

Enter the name of the attribute (owner in our example) into the name
field and then enter the value(s) to match into the value field (in our
case Standard:DivisionA.ProjectX and Standard:DivisionA.ProjectY)

Multiple values of a named filter are combined with OR.

imporiam  Multiple named filters are combined with AND.
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7.4 RSS Feeds

New alerts are also available as RSS feeds. Users can subscribe to their news
feed directly from their homepage:

@ i c et | _If: http: ff{demo.opencry. orgfopencrx-core-CRX/ i e '

|5ul:usu:ri|:ue to this page... |

guest@Standard oo goeEst
=

opencrx

en_LIS Sawve Settings

My Homepage @ Accounts Activities Pipeline »

i @ User Homepages = Guest, Joe O - My Homepage

7.5 Trouble Shooting Notification Services

The following table lists some of the common issues and how to fix them:

Problem Solution

The grids Workflow | - verify that the Segment Administrator created
Processes and/or Workflow Processes and Topics with the wizard
Topics are empty. Segment Setup

- click the filter button E4 to see all rows without filtering
(maybe you defined a default filter in the past?)

I started the - verify that you started the correct Subscription Handler
Subscription (each segment has its own Subscription Handler)

Handler but I never| . in case you upgraded to a new version of openCRX and
receive any Alerts /| forgot to delete Workflows and Topics provided by
Notifications openCRX, stop the Subscription Handler, delete
Workflow Processes and Topics, recreate Workflow
Processes and Topics with the wizard Segment Setup,
and then start the Subscription Handler again

- check the openCRX log files to find out whether
bad/corrupt data might be causing problems (e.g.
NullPointer Exception during Workflow execution)

I receive Alerts - verify that JavaMail is properly installed and the mail
triggered by my service properly configured (see chapter 8.1 Install and
Subscriptions but Configure Mail Resource and E-Mail Services for more
no Notification information)

E-mails - verify your e-mail settings (see E-mail Services)

- verify that the Servlet WorkflowHandler of the
respective segment is turned on
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8 E-mail Services

Please note that we have no intention to duplicate mail server (MTA) or
mail client functionality in openCRX as there are lots of excellent products
available (Open Source and commercial). It is our goal, however, that
openCRX integrates with all the major products that adhere to the
major standards and support standard protocols like SMTP, POP3, IMAP,
etc. This ensures that you can continue to use your favorite mail server (gmail,
postfix, etc.) and your favorite mail client (Thunderbird, Outlook, etc.).

Installation of JavaMail is required if you want to make use of E-mail

Services.
Important

The following figure shows the flow of mail messages between openCRX, mail
server, and mail client as it is supported with openCRX 2.5.2:

Browser

ObjectInspectorServiet

IMAPServiet ExportMailWo rkflow SendMailWorkflow

Mail Client

POP3 / POP3S f IMAP f/ IMAPS

Mailbaox ... Mailbox audit

Mail Server

Figure 37: Flow of e-mail messages between openCRX, MTA and mail client

In this chapter we will first guide you through the required installation and
configuration steps before we discuss various important use cases.
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8.1 Install and Configure Mail Resource and E-Mail Services

The following chapters explain how to install JavaMail and how to configure the
Java mail service and various in- and outbound E-mail services.

Please note that outbound E-Mail Services depend on the Servlet

| WorkflowHandler of the respective segment being turned on.
mporant

8.1.1 Installation of JavaMail and JAF
Detailed installation instructions are provided at the JavaMail home:
http://java.sun.com/products/javamail/FAQ.html

And here is the short version:
e Download JavaMail (at least version 1.4) from
http://java.sun.com/products/javamail/downloads/index.html
Put the file mail.jar into the directory JAVA_HOME\jre\lib\ext

Download JAF (JavaBeans Activation Framework, version 1.1.1 or newer)
from
http://java.sun.com/javase/technologies/desktop/javabeans/jaf/downloa
ds/index.html

e Put the file activation.jar into the directory JAVA_HOME\jre\lib\ext

Verify that you put the files into the above-mentioned directory,

which is not an openCRX installation directory!
Imporiant

The following instructions are dependent on your deployment scenario as the
steps for creating mail resources vary from application server to application
server. We provide instructions for Apache Tomcat.

8.1.2 Mail Resource for openCRX on Apache Tomcat

8.1.2.1 Add resource definition to openejb.xml

Open the file TOMCAT_HOME\conf\openejb.xml and add (or modify) the
mail resource definition. In the sample file below you must at least adapt the

pifepliTe]pie=leMluglalels to your own environment:
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Listing 7: File openejb.xml

<Resource id="mail/provider/CRX/segment/Standard" type="javax.mail.Session">
mail.debug true
mail.transport.protocol smtp
mail.smtp.user uWBEIShasEluls
mail.smtp.password |lgeEltyelae
mail.smtp.starttls.enable true
mail.smtp.auth true
mail.smtp.host |Wiysfelsgd
mail.smtp.port 25
mail.smtp.user UNESEISEableElls
mail.from uRguEERESae}
mail.store.protocol pop3s
mail.pop3s.host uijsterEls
mail.pop3s.port 995
mail.pop3s.auth true
mail.pop3s.user UNBEEE SN IE
mail.pop3s.password |uNgeEEiciielae

</Resource>

Additional information about configuration options of JavaMail is available from
the JavaMail home:

http://java.sun.com/products/javamail/FAQ.html

8.1.2.2 Mail Resource in web.xml

In the file web.xml in the directory <Tomcat Install Dir>\apps\opencrx-core-CRX\opencrx-core-
CRX\WEB-INF you must uncomment the following section:

Listing 8: Uncomment mail resource definition in web.xml

<!-- Wizards, Workflows (e.g. MailWorkflow), etc. can use mail resources.
Configure a mail resource for each used mail resource. -->
<resource-ref id="mail opencrx CRX Standard">
<res-ref-name>mail/provider/CRX/segment/Standard</res-ref-name>
<res-type>javax.mail.Session</res-type>
<res-auth>Container</res-auth>
</resource-ref>

Restart Tomcat for these changes to become active.

If you want to enable TLS/SSL connections to your mail server you
must also import the mail server's public key into the file cacerts of

fio your JRE:

Listing 9: Importing certificate into keystore cacerts

‘keytool -keystore cacerts -import -storepass changeit -file mailserver.cer



http://java.sun.com/products/javamail/FAQ.html
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8.2 Outbound E-mail

8.2.1 Outbound E-mail Configuration

openCRX users can configure e-mail accounts on their homepage indicating
where they would like to receive e-mail notifications (e.g. generated by
subscriptions):

e Click on My Homepage and select the grid Tab E-Mail.

e Next you click on the creator menu New > E-Mail Account to create a
new E-mail Account:

Alerts = Subscriptions || E-Mail
fH Q New Edit View

L] I:l E-mail address = Reply arl @ emai ﬂnmunt%‘h -

Figure 38: Create a new E-Mail Account — step 1

e Now you can configure your E-Mail Account for outbound e-mail service:
Untitled - E-Mail Account

General | Syztem H
E-mail addrez=: user@mycompany.com Default:
Reply address: noreply@mycompany.com

Qutgoing Mail Service:

Incoming Mail Service:

Quealifier: (must be wnigue, i.e. leave unchanged unless you know what you are doing...)
C-LmEISGEduFvitsTriNme

[ Save ]Cancel
Figure 39: Create a new E-Mail Account - step 2

The various fields have the following meanings:

E-mail address: enter your e-mail address (i.e. the address
where you would like to receive e-mail notifications)

Reply address: is also used for the From field

Default: check if this is your default e-mail address (notifications
will only be sent to your default e-mail address)

Outgoing Mail Service: |eave this empty (unless the default
configuration does not suit you; the default name of the mail
service is /mail/provider/<provider>/segment/<segment> )

Incoming Mail Service: |eave this empty (unless the default
configuration does not suit you; the default name of the mail
service is /mail/provider/<provider>/segment/<segment> )
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If a user does not define the name of the mail service in

= his E-Mail Account settings the default name
/mail/provider/<provider>/segment/<segment> is used;
if there is no resource with this name the fallback name
/mail/provider/<provider> is used (and if this name does
not exist either, then an error is logged).

e Click the button | S3ve | to commit the new E-Mail Account. The grid
E-Mail should now contain an entry for the new E-Mail Account:

Alerts | Subscripticns EE-I".ﬂaiIE

o Q Mew  Edit View

L D E-mail address = Reply address = Default = Cutgoing = Incoming =
@ USEr@mycompany.com noreply@mycompany.com L

Figure 40: Create a new E-Mail Account — step 3

e On your Homepage you can provide additional information related to
E-Mail Notifications:

% guest, - My Homepage

File  Edit Find View  Actions Security  Wizards
Genera Charts ECIpti-}nsé System
E-mall Optins

E-mail subject prefix [CR¥: Standard] Web access URL:  hittp:/M 27.0.0.1:2080/opencrx-core-CRX
Figure 41: E-mail subject prefix and Web access URL

The meaning of the two fields is as follows:

E-mail subject prefix: enter a string that might help you identify
or filter e-mails from your openCRX server (optional, i.e. you can
also leave this empty) - the entered string is prepended to the
subject line of generated e-mails.

Web access URL: enter the URL of the openCRX instance at hand;
if entered correctly, generated e-mails will contain URLs that allow
you to connect to your openCRX server with a single click.

You can easily test your e-mail settings if you create a subscription for Account

Modifications (see Example Subscription — Account Modifications) and then
work through the following steps:

e create a new account (e.g. a new contact)

e navigate to your Homepage and check whether you actually received an
alert related to the newly created account

e next click on the Grid Tab Pending / Completed Workflows on your
homepage (unhide it by clicking on [>] if it is not visible)




openCRX Admin Guide - Version 2.5.2

E-mail Services

e there should be (at least) two entries (you might have to sort the column
Started on to locate recent entries):

o org.opencrx.kernel.workflow.SendAlert (which generated the Alert)

o org.opencrx.mail.workflow.SendMailNotificationWorkflow (which was
responsible for sending the E-mail Notification)

e click on the icon of the respective grid icon to inspect the corresponding

Workflow Process object

e the grid Action Log Entries contains the message body of the e-mail that
was sent or an error message if the workflow failed (please note that
even if you see a "timeout" error message the e-mail might have been
sent; timeouts are typically caused by e-mail servers with high latency -
try sending out notifications through a mail server that is responsive).

Action Log Entries | [Properties III

2, Can not send mail:
MessagingException

2. Can not send mail:
MessagingException

MNew )

? [ ooy E

I* - Name - Correlation Description

L1

2, openCRX SendMail: Object Invoked:
test 2

http://localhost/opencrx-core-CRX/ObjectInspector

By Workflow:
http://localhost/opencrx-core- CRX/ObjectInspecto

Triggered By Event:
OBIECT_CREATION

Triggered By Subscription:
mxxecMQBEdqQW4VTSPz34w
http://localhost/opencrx- core- CRX/0ObjectInspector
Can't send command to SMTP host;

nested exception is:

java.net.SocketException: Software caused connec

Could not connect to SMTP host: mail.crixp.com, pt

Figure 42: Example of outbound E-mail Action Log Entries

8.2.2 Export E-mails

Please refer to chapter 9.4 Mailstore / IMAP.
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8.2.3 Send E-mails directly from openCRX
Any openCRX E-Mail Activity can be sent as e-mail directly from openCRX:

Browser

ObjectInspectorServiet

SendMailWorkflow

Internet

SMTP

Mailbox ...

Mail Server

Figure 43: Send E-Mail from openCRX - Overview

The idea behind this functionality is less that you will use openCRX as a mail
client, rather the SendMailWorkflow is an important element of the openCRX
campaignh management functionality. E-Mail Activities of type “E-Mails” are
controlled by the Activity Process E-mail Process. Send E-Mail Activities to all
recipients by executing the operation Actions > Follow Up and then selecting
the Transition Send as mail as shown below:

‘@ 10007596 : Re: Update API; v1.24 - E-mail

s

Transition: i Send as mail i
Follow wp title:
Follow wp tesxt: —

| C(Rl-’.’amJ

Flgure 44: Send E-Mail from openCRX with Actions > Follow Up

Please note that the transition "Send as mail” is only available after

the Transition “Assign” has been executed.
Important

Media attached to E-Mail Activities are sent as e-mail attachments.
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8.2.4 Send E-mails as Attachments to your Mail Client

Any openCRX E-Mail Activity can be sent to your mail client as an attachment.
The idea behind this functionality is that you might want to put some finishing
touches on an e-mail before iou actually send it from your mail client:

Browser

ObjectInspectorServiet

BExportMailWorkflow

Mail Client

POP3 f POP3S / IMAP / IMAPS

Mailbox ...

Mail Server

Figure 45: Send E-Mail as Attachment from openCRX - Overview

E-Mail Activities of type “E-Mails” are managed by the standard Activity
Process E-mail Process, i.e. they can be exported to the user's default mail
account by executing the operation Actions > Follow Up and then selecting the
Transition Export as mail attachment:

@ 10007596 - Re: Update API; v1.24 - E-mail

gt

Transition: iEnport as mail attachment § w
Follow up title:
Follow wp text: [

o e ]

Fig'ure 46: Export E-Mail from openCRX with Actions > Follow Up

Please note that the transition “Export as mail attachment” is only

available after the Transition “Assign” has been executed.
Important

Exported messages are sent as attachments to the user's default mail
address. See Outbound E-mail Configuration for details.

Media attached to E-Mail Activities are sent as e-mail attachments.
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8.2.5 Send E-mails to Fax-/SMS-Gateways

The SendMailWorkflow supports mail gateways if you set the attribute gateway
of the respective e-mail activity. The gateway address is used for addresses
which are not of type EmailAddress. For example, in the case of a phone
number, the address is converted to an e-mail address as follows:

e take the address (e.g. phoneNumberFull in case of phone numbers)

e remove any characters other than digits and letters

A\ S /4

e convert “+” (plus sign) to (underscore)

e append domain part of gateway address

Example: if the domain address of an e-mail activity is set to the email address
noreply@fax-gateway.opencrx.org, the the phone number +41 (44) 111-2233
is converted to the email address _41441112233@fax-gateway.opencrx.org.

This conversion feature allows you to mix e-mail addresses and phone
numbers in member lists of address groups. Depending on the recipient's type
of addresss the SendMailWorkflow will either send an e-mail to the listed
e-mail address as is (e-mail address) or first convert the recipient's phone
number to an e-mail address so that the resulting e-mail can be handled by
your fax-/sms-gateway.

If you are looking for reliable fax software, you might want to look

" into Hylafax+ http://hylafax.sourceforge.net/ (Linux only).
n



http://hylafax.sourceforge.net/
mailto:_41441112233@fax-gateway.opencrx.org
mailto:noreply@fax-gateway.opencrx.org
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8.3 Inbound E-mail
Please refer to chapter 9.4 Mailstore / IMAP.

8.3.1 Import E-mails

Please refer to chapter 9.4 Mailstore / IMAP.

8.4 Trouble Shooting E-mail Services

The following table lists some of the common issues and how to fix them:

Problem

Solution

openCRX does not
initiate TLS session
with mail server

It seems that JavaMail sometimes does not (even try
to) establish a TLS session when connecting to a mail
server (smtp) if the certificate of the mail server has
not been imported into the keystore. If the mail server
requires TLS for authentication (e.g. SASL) and
authentication is required to relay messages such
failure to establish a TLS session will prevent openCRX
from properly sending outbound mail.

If you intend to use TLS/SSL to secure the
connection to the outbound e-mail server
Tin (smtp) we recommend you import the mail
server certificate into the keystore.

Listing 10: Importing Certificate

cd $JAVA HOME/lib/security
keytool -import -alias <dom> -file <name>.cer -keystore cacerts

Replace <dom> with the domain of the mail server
(e.g. mail.company.com) and <name> with the name
of the certificate file.

I receive Alerts
triggered by my
Subscriptions but no
Notification E-mails

- verify that JavaMail is properly installed and the mail
service properly configured (see chapter 8.1 Install
and Configure Mail Resource and E-Mail Services for
more information)

- verify your e-mail settings (see E-mail Services for
details)

- verify that the Serviet WorkflowHandler of the
respective segment is turned on
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9 Groupware Services

openCRX features the following groupware services:

Type of Service Standard Server Provider

vCard Server VCF openCRX/core (native provider)

Calendaring FreeBusy openCRX/core (native provider)
iCalendar (ICS) |openCRX/core (native provider)
CalDAV native provider planned for v2.6.0

Mailstore IMAP openCRX/core (native provider)

9#&%&%%%&9#2 (not available anymore)



http://en.wikipedia.org/wiki/Lightweight_Directory_Access_Protocol
http://www.kingsmountain.com/ldapRoadmap.shtml
http://www.opends.org/
http://www.opends.org/

openCRX Admin Guide - Version 2.5.2

Groupware Services

Composition Privacy
General | Addressing | Spelling

Address Autocompletion
When addressing messages, look for matching entries in:
Local Address Books

Directory Server: Mone

Automatically add outgoing e-mail addresses to my:

n L =

Attachments

Collected Addresses

Advanced

Lightning

<

Funambaol

: Edit Directories. ., :

W

QK

] [ Cancel
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Microsoft LDAP Directory

Connection | Search
Server Settings
Search timeout in seconds: 30

Specify the maximum number of entries yau 200
want to return after a successful search:

Search Base

") Use Default

{(®) Custom: |dc=accounts,dc=5tandard,dc=CRX,dc=of

Browsing

[ ]Enable Browsing {requires server support)

[ CIK. ][ Cancel H Apply
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9.2 openCRX vcard Servlet

The openCRX vcard servlet does for accounts what the openCRX ical servilet
does for activities: it makes them available to third-party clients who access
the openCRX server with the http protocol.

9.2.1 Account Selectors

openCRX can map sets of accounts to a vcard file (a sequence of vcards). The
resulting vcard file can be imported and/or processed by vcard-enabled clients
like Outlook, Thunderbird, etc. At this time, account filters are the only
supported account selectors. Account filters support reading and updating, but
not creating of accounts (R=read, U=update):

Set of Accounts RUC vCard Selector

Account Filter RU accounts?id=<provider>/ <segment> /filter/ <account filter name>&type=vcf

VCF Selector Examples:

accounts?id=CRX/Standard/filter/All+Accounts&type=vcf
accounts?id=CRX/Standard/filter/Accounts+with+missing+or+broken+vCard&type=vcf

Use the openCRX Wizard “Calendar / vCard Connection Helper” to
generate valid VCF Selectors. You can start the wizard from your
Tio homepage:
My Homepage | Accounts Activities Pipeline »
Y User Homepages » Guest, Joe O - My Homepage

File Edit Find View Actions Security Wizards

Segment Setup.

General | Charts || Options || System Creste Work/Expense Record
Work/Expense Report...

Contact: Guest, Joe O LCalendar / vCard Connection Helper...;

Timeline... L}:

Choose the options “vCard” and “Account Filter” and then select the
desired account filter:

Role of rezource:; vCard )
Selector type: Account Filter [aal]
Account Filter: All Accounts ]
wZand Opilons

Hint: you can sef MAaXACCOUNTS in e Componeni-Configuration of Bie voardSende! (detaul s 500}

(_http:.-'.-'d £mo.opencry.org/opencrx-veard-CRX/aceounts ?id=CRX/Stand ard/fiter/All+-Accountz&type=vcf ]
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9.2.1.1 Connecting MS Outlook to the openCRX vcard servlet

Detailed instructions on how to connect MS Outlook are available from
http://www.opencrx.org/opencrx/2.4/0utlook_ICS_VCF_adapter.htm

9.2.1.2 Connecting Thunderbird to the openCRX vcard serviet

A Thunderbird add-on is available that enables you to map address books to
openCRX account selectors:

http://opencrx.mozdev.org/

| S
L]} o~
G ‘4 L1 -/ dl . X 20 Mame or Ema
MNew Contact Mew List | Properties  Write Imnport Export Delete
Address Books Name ~ | Email Organization Work Phone B
) Personal Address Book 1L=| Agron Thunde.rblrd Aaronsen aaron2@host.invalid
) cRIxP_184_All_Accounts || =t hunderbird Dude
Lj' demo (TB) \“=|Roger Thunderbird Rabbit r.rabbit@testbusiness.com Rabitts Clock Shop AG  +41 (78) 685-1235
[ Collected Addresses \“=|Tim Thunderbird Jones tim. jones @business.com CRIXP Corp. +41 (44) 508-233%
\“=|Tim Thunderbird Jones Jr. tim. jones @business. com 1000050 +41 (44) 508-233%
. Edit Contact for Tim Thunderbird Jones
Contact | Private | Work || Other
Address: | [Mr.][Joe Guest][cfo CRIXP Corp.][Technoparkstr. 1]
City: | Zdrich
State/Province: | ZH ZIPPostal Code: | 8005
Country: | Switzerland [CH]
Web Page: | http:/fwww.opencrx.orgf
Birthday: | 14-04[[»]| | 2002 or |7
Contact URL:  Click here to open the contactn your browser
oK ] [ Cancel
Contact Phone
Display Mame: Tim Thunderbird Jones Work: +41 (44) 508-9999
Nickname: jg Home: +1 (314) 739-1234
Email: tim.jones@business.com Mobile: +41 (79) 444-3333
Additional Email: tim.jones @home.net
Work
Home Director
[Mr.][Joe Guest] [cfo CRIXP Corp.] CRIXP Corp.
[Technoparkstr. 1] [Mr.]1[Tim J. Thunderhird] [654
Zrich, ZH 8005 California Ave.]
Switzerland [CH] Gebiian Palo Alto, CA 94306
htip: . opencrx.org/ United States of America [US] et fap
http: ffumew, crixp. com/
Other
Birthday: Sunday, April 14, 2002
5 matches found Finished importing at 11:13:02



http://opencrx.mozdev.org/
http://www.opencrx.org/opencrx/2.4/Outlook_ICS_VCF_adapter.htm

openCRX Admin Guide - Version 2.5.2 Groupware Services

9.3 Calendaring

9.3.1 Calendar as a Set of Activities

openCRX supports a wide range of types of activities, including Tasks,
Meetings, E-Mails, Phone Calls, etc. Even though all activities are kept in a
single location (think of a box containing activities), openCRX offers a
multitude of mechanisms to structure, filter, and group activities:
e activities can be assigned to activity groups, which enables you to
group them by Tracker, Category, and Milestone
e activities can be filtered with predefined filters (e.g. activities filtered
to a user's homepage, activities filtered by resource) and user-defined
ActivityFilters (either at a global level or at the level of an activity group)

To fully understand the power of this approach, consider a large project X (e.g.
building a power plant) with millions of activities. With openCRX, a project is
typically mapped to an activity tracker (e.g. all activities of project X are
assigned to the activity tracker Project X). As a large project is often times
structured, i.e. broken down into subprojects, milestones, etc., let us assume
that the respective subset of activities related to Project X is assigned to an
activity group Milestone 2. With openCRX, it's a single click and you can
browse all the activities assigned to Milestone 2, or you can view all these
activities in a calendar application like Sunbird or MS Outlook:

Figure 49: openCRX Activity Groups / openCRX Activity Filters

It goes without saying that different users have different needs. It is also quite
natural that the needs change over time. With openCRX, it is easy to deliver as
there are virtually unlimited possibilities to slice and dice the universe of
activities. For example, instead of pulling a set of activities based on their
assignment to activity groups, there are many use cases where one would like
to define a filter to define a subset of activities. On the one hand, openCRX
features lots of default filters, on the other hand, there are powerful tools to
define custom filters virtually any way you like. For example: an auditor might
be interested in all activities involving a particular subcontractor, another user
could be interested in browsing through all the meetings related to Project X.
Hence, in the context of calendaring it helps if you think of a calendar as a set
of activities, nothing more and nothing less.
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9.3.2 Calendar Selectors

openCRX can map each of the above-mentioned set of activities to a calendar.
Depending on the mapping, the resulting calendar can be presented in various
formats, e.g. ICS calendar, Free Busy calendar, XML file, Timeline, etc. Some

typical ICS calendar selectors are listed below (R=read, U=update, C=create):

Set of RUC ICS Calendar Selector
Activities
Tracker RUC | activities?id=<provider>/<segment>/tracker/<name>&type=ics
... Filtered RUC | activities?id=<provider>/<segment>/tracker/<name> /filter/ <filter name>&type=ics
Category RUC | activities?id=<provider>/<segment>/category/<name>&type=ics
... Filtered |RUC | activities?id=<provider>/<segment>/category/<name> /filter/ <filter name>&type=ics
Milestone RUC | activities?id=<provider>/<segment>/milestone/<name>&type=ics
... Filtered RUC | activities?id=<provider>/<segment>/milestone/<name> /filter/ <filter name>&type=ics
Global Filter | RU activities?id=<provider>/ <segment> /globalfilter/ <activity filter name>&type=ics
Homepage |RU activities?id=<provider>/ <segment>/userhome/ <home qualifier>&type=ics
Resource RU activities?id=<provider>/ <segment>/resource/ <resource name>&type=ics
Birthdays R bdays?id=<provider>/ <segment>/filter/ <account filter name>&type=ics
Use the openCRX Wizard “Calendar / vCard Connection Helper” from
- your Homepage to generate valid Calendar Selectors:
n

My Homepage  Accounts Activities Pipeline »

Y User Homepages » Guest, Joe O - My Homepage

File Edit Find View Actions Security Wizards
Segment Setup...

General | | Charts || Options | System Create Wod/Expense Record
Work/Expense Report...

Contact Guest, Joe 0 iCalendar / vCard Connection Helper. ..

Timeline... L}‘:

Choose the option “Calendar” and then make your selections:

Role of rezource: Calendar [v]
Baszed on: My Homepage V
My Homepage: admin-5tandard, [admin-5tandard] V
Calkendar Optlons

Generate: activities [from Activities) V
Type: ice £
Fiter dizabled: false (default) V

Hint you can st MAaXACtivities i ke Component-Configuration of e ICalSen (detaul ks 500

Gﬁp:;‘;‘d&mu.up&n crx.orgiopencre-ical-CRX activities #id=CRX/Standard/userhome/guestityp 5=i|:3]
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CalDAV calendar selectors look as follows (R=read, U=update, C=create):

Set of RUC CalDAV Calendar Selector
Activities
Tracker RUC | <provider>/<segment>/tracker/<name>

... Filtered |RUC | <provider>/<segment>/tracker/<name> /filter/ <filter name>

Category RUC | <provider>/<segment>/category/<name>

... Filtered RUC | <provider>/<segment>/category/<name> /filter/ <filter name>

Milestone RUC | <provider>/<segment>/milestone/<name>

... Filtered |RUC | <provider>/<segment>/milestone/<name> /filter/ <filter name>

Global Filter | RU <provider>/ <segment>/globalfilter/ <activity filter name>

Homepage |RU <provider>/ <segment>/userhome/ <home qualifier>

Resource RU <provider>/<segment>/resource/ <resource name>

Use the openCRX Wizard “Calendar / vCard Connection Helper” from
your Homepage to generate valid Calendar Selectors:

My Homepage | Accounts Activities Pipeline w»

Y User Homepages » Guest, Joe O - My Homepage

File Edit Find View Actions Security Wizards
Segment Setup...

General | | Charts || Options | System Create Wor/Expense Record. .

Work/Expense Report...

Contact: Guest, Joe O iCalendar / vCard Connecticn Helper. .

Timeline... L}:

Choose the option “Calendar” and then make your selections (set
Type to CalDAV for CalDAV calendar selectors):

Role of resource: Calendar ]
Based on: My Homepage [V]
My Homepage: Guest, Joe O [guest] [V]

Calendar Cptions

Generate: activities (from Activities) [»]

Type: CalDAV [+

Hint: you can set MAaxACtivities in e Componeni-Configuration of fie I0aiSaniet (detaul I 500)

(_U RL: hitp:/idemo.opencrx.org/opencrx-caldav-CRX/CRX/ Standard/ugerhomesg uest]

The wizard can also build URLs for CalDAV calendar collections:

Set of RUC CalDAYV Calendar Collection Selector

Calendars

Collection RUC | <provider>/<segment>/user/ <principal name>/profile/ <profile name>

Example . http://demo.opencrx.org/opencrx-caldav-CRX/CRX/Standard/user/guest/profile/MyCals
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9.3.3 openCRX Activities mapped to Calendar Events

openCRX activities correspond to calendar events (or tasks). An event's iCal
representation is stored in the corresponding activity's iCal attribute:

*1t 1000100 : Presentation XYZ - Incident

File Edit View  Actions Security

[ BEGIN:VCALENDAR
PRODID:AOPENCRXANONSGML Version 1EM
WERSION:2.0

BEGIN:VEVENT

UID: c8effall-eb54-11dc-80b1-db85e55ascaz2
CLASS:PUBLIC
DTSTART:200803068T200000Z
DTEND:20080306T220000Z
DUE;WALUE=DATE: 59591231
LAST-MODIFIED:20080306TOS1221Z
LOCATION:crx Headquarter

DTSTAMP 20080306T0S1221Z
DESCRIFTION:new widget
SUMMARY:Prezentation X' Z & #1000100
PRIORMY:2

ENDXWEWENT

L ENDXWVCALENDAR

iCal:

X

Figure 50: An openCRX activity's iCal representation

In the openCRX standard GUI the same activity is presented as follows:

' 1000100 : Presentation XYZ - Incident

File Edit View  Actions Security

{| Details Bystem
Mame: Presentation XYZ State:
Activity number: 1000100 Priority:
Description: new widget Sewverity:
Assigned to: guest, Scheduled start:

Mizcelaneous #1:
Mizcelaneous #2:

Scheduled end:

Mizcellaneous #3: Due by:
Activity type: Bugs + Features % complete:
Last Transition: Assign Actual start:
Process state: In Progress Actual end:
mchdert: Mamsgemen

Reporting account: Incident type:

Reporting contact:
Customer =atizfaction:

admin-Standard,
MiA

Incident origin:
Reproducibility:

Location: crx Headquarter iz all day event:

Detailed description:

Scheduled end (original):

X

E Open

[4] Urgent
Ni&
3612008 9:00:00 PM
J6/2008 11:00:00 P

12/31/9999 1:00:00 AM

20
362008 9:11:49 AM

HiA
NiA
NiA

Figure 51: An openCRX activity in the standard GUI
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As the above activity is assigned to “guest” it is automatically filtered to the

homepage of the user guest:

@ guest, - My Homepage

File Edit Find View Actions Security  Wizards

General | | Charts | Options || System
Contact: guest,
Betivities
e o, View
Il [] sched. start - Due by - ® - Name - Activity# — State — 1=
° 62008 1?"I3_”9999 B Presentation In L
iy 1:00:00 1000100 Assign 20
S00:00PM XYZ % Progress

Figure 52: An openCRX activity filtered to a user's homepage

Follow up = % - Assigned to -

guest,

For the purpose of this guide this activity is also assigned to the tracker
“shared”. In various of this guide's examples we will make use of these facts
by using the Calendar Selectors activities?id=CRX/Standard/userhome/guest

and activities?id=CRX/Standard/tracker/shared.
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9.3.4 Calendaring / Free Busy

Free Busy is part of the iCalendar standard (RFC 2445) for calendar data
exchange (see also Wikipedia). Many calendar clients rely on this information
for group scheduling. openCRX can derive free busy information on-the-fly
from the respective activities; as most clients do not support authentication
the default configuration of the openCRX ical servilet does not require
authentication to retrieve Free Busy information. However, the principal guest
must exist (but you can disable the login):

Free Busy URL (without authentication, requires openCRX principal guest):
http://<crxServer>:<Port>/opencrx-ical-<Provider>/freebusy
?id=<Provider>/<Segment>/<Calendar Selector>

Example:
http://localhost:8080/opencrx-ical-CRX/freebusy?id=CRX/Standard/tracker/main

Please note that free busy information is provided by the openCRX server in a
read-only fashion (i.e. free busy clients cannot update such information).

If you prefer authentication for Free Busy clients you can add the url-
pattern /freebusy to the web-resource-collection (in the file web.xml
T of the ical servlet).

9.3.4.1 Free Busy Configuration of Thunderbird

Thunderbird 2.0 supports free busy if the following add-ons are installed:

e Lightning (at least v0.9)

e SOGo Connector Thunderbird Extension (at least v0.95)
Once the SOGo Connector is installed, Contact Cards of the Thunderbird
Address Book will feature a tab CalDAV. This is where you can enter the URL:

Edit Card for John Lucas Doe II|

Contact|| Address | Other | Other data || Photo | CalDAY | gContactSync | gContactSync 2

Freebusy URL: | htip://demo. opencrx. org fopencrx-cal-CRY freebusy ?id =CRY 5tz

9.3.4.2 Free Busy Configuration of MS Outlook

See http://support.microsoft.com/kb/291621. Please note that Outlook does
not support SSL with free busy.



http://support.microsoft.com/kb/291621
http://www.scalableogo.org/downloads/frontends.html
http://www.mozilla.org/projects/calendar/lightning/download.html
http://www.mozilla.com/en-US/thunderbird/
http://en.wikipedia.org/wiki/ICalendar#Free.2Fbusy_time_.28VFREEBUSY.29
http://en.wikipedia.org/wiki/Calendar
http://tools.ietf.org/html/rfc2445
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9.3.5 Calendaring / iCalendar (ICS)

iCalendar is implemented/supported by a large humber of products (see

RFC 2445 or Wikipedia for information about the iCalendar standard,
sometimes referred to as “iCal”). openCRX can derive iCalendar information
on-the-fly from the respective activities. iCal clients must authenticate to read
and/or write iCalendar data.

ICS URL (with authentication):

http://<crxServer>:<Port>/opencrx-ical-<Provider>/activities
?id=<Provider>/<Segment>/<Calendar Selector>&type=ics

Example:
http://localhost:8080/opencrx-ical-CRX/activities?id=CRX/Standard/tracker/main&type=ics

See chapter 9.3.2 Calendar Selectors for information on how to

- construct calendaring URLs.

n

Please note that calendars without “C” (create) in the table provided
in chapter 9.3.2 Calendar Selectors do not support creation of new
events/tasks with external ICS clients. The reason being that without
a well-defined ActivityCreator associated with the respective calendar
selector it is not possible to create an activity and assign it to the
appropriate activity groups.

Important

While the mapping of most of openCRX's activity attributes to iCal attributes is
obvious, the following hints might still be helpful:

VEVENT:

e Activity.disabled==true --> STATUS:CANCELLED

e Activity.percentComplete== --> STATUS:TENTATIVE

« percentComplete>0 --> STATUS:CONFIRMED
VTODO:

e Activity.disabled==true --> STATUS:CANCELLED

e Activity.percentComplete== --> STATUS:NEEDS-ACTION

e Activity.percentComplete>0 --> STATUS:IN-PROCESS

o Activity.percentComplete==100--> STATUS:COMPLETED

Please note that Activity.percentComplete cannot be changed upon import of a
vCard as openCRX activities are managed by activity processes. Hence,
changing the status of an activity outside of openCRX does not change the
status of this activity in openCRX (even if it is reimported).



http://en.wikipedia.org/wiki/ICalendar
http://tools.ietf.org/html/rfc2445
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9.3.5.1 ICS Configuration of Thunderbird/Lightning and Sunbird

Thunderbird 2.0 with the Lightning add-on (at least version 0.9) is a fully-
fledged calendar client and offers virtually the same calendaring functionality
as the stand-alone calendar client Sunbird (at least version 0.9). Creating a
remote calendar (hosted on your openCRX server) is rather straightforward:
start Thunderbird/Lightning or Sunbird

select the menu File > New Calendar

in the dialog window Create New Calendar you select On the Network
then you select iCalendar (ICS)

enter an ICS URL into the field Location;

example: the user guest would connect to this openCRX homepage with the URL
http://127.0.0.1:8080/opencrx-ical-CRX/activities?id=CRX/Standard/userhome/guest&type=ics

See chapter 9.3.2 Calendar Selectors for information on ICS URLs

give your calendar a name and pick a color of your choice

That's it. You are connected to openCRX:

esentation %YZ Jf
00100

Title: Presentation ¥YZ jf #1000100
Location: corx Headguarter
Date: Thursday, March 06, 2008 21:00 - 23:0

new widget

aaaaa |
Version 0.9 of Thunderbird/Lightning and Sunbird requires a life connection to
openCRX (i.e. no support for offline viewing/editing) unless you enable the
experimental Cache of Ligthning/Sunbird.

9.3.5.2 ICS Configuration of MS Outlook

Out of the box Redmond's flagship MS Outlook 2007 does not offer you much
choice with ICS calendars. You are stuck with one of the following 2 options:
e Published Calendars
are local calendars published to a remote location, but there is no sync
with that remote calendar (i.e. changes to the remote calendar will never
automatically make it back into your Outlook)
e Internet Calendar Subscription
These calendars are striclty read-only in Outlook, i.e. not very useful...
Not to leave you out in the rain, we put together a bunch of VBA scripts that
teach your Outlook a few new tricks. The scripts and detailed instructions for
both MS Outlook 2003 and MS Outlook 2007 are available from
http://www.opencrx.org/opencrx/2.4/0Outlook_ICS_VCF_adapter.htm

i~ Calendar - Microsoft Outlook
File Edit View Go Tools Actions Help Funambol Adobe PDF

EEHEW - j:;J | = Gf | @} Searchaddressbooks - | (@) = ,_r,SE,ICS.getCaIt%dars &% ICS.putCalendars =



http://www.opencrx.org/opencrx/2.4/Outlook_ICS_VCF_adapter.htm
http://www.mozilla.org/projects/calendar/sunbird/
http://www.mozilla.org/projects/calendar/lightning/download.html
http://www.mozilla.com/en-US/thunderbird/
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9.3.5.3 ICS Configuration of Zimbra

Zimbra (v5.0.14 GA Release) does not offer you much choice with remote ICS
calendars. It is possible to subscribe to a remote calendar, but in read-only
mode; furthermore, only a minimal set of iCal attributes is actually visible in
the Zimbra calendar. Nevertheless, here is how to subscribe:

e connect to your Zimbra server and login
e click on the tab [Calendar]
e click the button [New Calendar] and then populate the dialog as follows:

Create New Calendar

Name: | openCRX Test Cal

[ ] Exdude this calendar when reporting free /busy times

Synchronize appointments from remote calendar

LJRL: | http://user:password @demo. opencrx. org opencri-ical-CF

| K. | Cancel

Please note that the ICS URL in the field URL must also include
your openCRX user name and password because Zimbra does

Imporiant ot really manage your remote credentials.

9.3.5.4 ICS Configuration of iPhone

With iPhone 0S3.0 you can connect to any remote ICS calendar (read-only) as
follows:

on your iPhone home screen, tap the icon Settings
tap on Mail, Contacts, Calendars

tap on Add Account...

tap on Other

tap on Add Subscribed Calendar

enter or paste the ICS URL into the field Server

tap [Next] to verify the account information

If you get a message “"Cannot Connect Using SSL” tap [No] to
move on to the next screen where you can enter the connection
e details.



http://www.zimbra.com/
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verify/complete your subscription information as follows:

_allOrange © 10:08 943% b

Server verify the ICS URL

Description any text you like Aagesint o
(default is the ICS URL) Subscribed Calendar Information

Username your openCRX user name Server 'R01&resource=activities.icq

Password your openCRX password | Description My openCRX calendar |

Use SSL if you use SSL, set to [ON], . '

otherwise [OFF] EWEEEUEE
Remove Alarms as you prefer EEEEEE

° EEIIIEINN a

return

tap [Next]

if you use SSL in combination with a self-signed certificate, you will get a
message Unable to Verify Certificate --> tap Accept

if everything works out, you can tap Save to store the settings and your

calendar will be available in the Calendar App from the iPhone's home
screen

9.3.5.5 Deleting Events

The openCRX ICS Adapter does not support deleting events (because deleting
objects is typically not an acceptable operation in an enterprise environment).
openCRX does support disabling of objects, however. If there is a need to
disable events directly from your ICS Client, here is how to do it:

Assuming you have a remote calendar CAL with the URL <U> defined in
your ICS client, define a new remote calendar CAL-trash with the URL
<U>&disabled=true (i.e. append the string “"&disabled=true” to the
URL); the name of the calendar is not important, we just call it "CAL-
trash” to indicate that it contains disabled activities.

example:

existing calendar CAL (showing only events that are not disabled) with the URL
http://127.0.0.1:8080/0opencrx-ical-CRX/activities?id=CRX/Standard/userhome/guest&type=ics

the URL of the calendar CAL-trash showing events that are disabled is
http://127.0.0.1:8080/opencrx-ical-CRX/activities?id=CRX/Standard/userhome/guest&type=ics&disabled=true

to delete an event of your calendar CAL, move the event from the
calendar CAL to the calendar CAL-trash
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9.3.5.6 iCalender Guard Event

If you retrieve an iCalender from the openCRX ICS Adapter, the very first
event is a so-called Guard Event:

e the Guard Event is always the first event delivered by the ICS Adapter
e the attribute SUMMARY corresponds to the Calendar-ID
e the attribute DTSTART is set to 19000101T000000Z

The openCRX ICS Adapter supports the creation of new events/tasks as long

as a calendar's Guard Event is posted to the adapter together with the new
event/task. The openCRX ICS Adapter also verifies the UID of the Guard Event.

9.3.5.7 VEVENT vs. VTODO

Many calendar applications differentiate between events (entries in a calendar
with well-defined start and end date) and tasks or to-dos (entries in a task list
with a well-defined due date). openCRX also supports this distinction. openCRX
can even convert activities from VEVENT to VTODO and vice versa without loss
of information. To convert an openCRX activity from one type to the other,
simply edit the activity and change the iCal type in the respective drop down
as shown below:

iCal type: ‘ Automatic v
iCal: Automatic

VEVENT %

VTODO

BEGIN:VEVENT

UID:fdb9330a-a774-11dc-93d1-a9d3ecf296d9

CLASS:PUBLIC

DTSTART:20071213T1620332

DTEND:20071213T1720332

DUE;VALUE=DATE: 99991231
LAST-MODIFIED:20080910T112235Z
DTSTAMP:20080910T112236Z w

Figure 53: iCalendar conversion between VEVENT and VTODO
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9.3.6 Calendaring / CalDAV

CalDAV is implemented/supported by a growing number of products (see
http://caldav.calconnect.org/ or Wikipedia for information about the CalDAV
standard). openCRX is a fully-fledged CalDAV server; the functionality is
implemented by a native CalDAV servlet. CalDAV clients must authenticate to
read and/or write CalDAV data.

CalDAV URL for individual calendar:

http://<crxServer>:<Port>/opencrx-caldav-
<Provider>/<Provider>/<Segment>/<Calendar Selector>

Example:
http://localhost:8080/opencrx-caldav-CRX/CRX/Standard/tracker/main

CalDAV URL for CalDAV calendar collection:

http://<crxServer>:<Port>/opencrx-caldav-
<Provider>/<Provider>/<Segment>/user/<principal name>/profile/<Calendar
Profile>

Example:
http://localhost:8080/opencrx-caldav-CRX/CRX/Standard/user/guest/profile/MyCals

See chapter 9.3.2 Calendar Selectors for information on how to
construct calendaring URLs. The easiest way to construct CalDAV

o URLs is to use the openCRX Wizard “Calendar / vCard Connection
Helper” from your Homepage.

Please note that calendars without “"C” (create) in the table provided
in chapter 9.3.2 Calendar Selectors do not support creation of new
events/tasks with external CalDAV clients. The reason being that
without a well-defined ActivityCreator associated with the respective
calendar selector it is not possible to create an activity and assign it
to the appropriate activity groups.

In the case of calendar collections/profiles, it depends on the feed
whether the respective calendar supports activity creation or not. If
openCRX can determine a well-defined ActivityCreator, activity
creation is supported, otherwise not.

Imporiant
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9.3.6.1 CalDAYV Collections

Some CalDAV clients (e.g. Apple's iPhone) support CalDAV collections. With
openCRX you can define CalDAV collections as follows:

e nhavigate to a user's homepage
e click on the tab [Calendar Profiles] and select New > Calendar Profile:
My Homepage Accounts Activities Pipeline »

W User Homepages = Guest, Joe O - My Homepage

]
File Edit Find View Actions Security Wizards

General | | Charts  Options | | System | *

Contach: Guest, Joe O

Alerts  Subscriptions E-Mail | Pending / Completed Workflows  History | Favorites Media | Object Finders | | Calendar Profiles
et q, Mew Edit View

L Name = Calendar meiﬁ Description =
MyCals

e enter at least a name for your new collection, e.g. MyCals, and then
click [Save]
e navigate to this new calendar profile and then add the desired feed(s),
e.g. an Activity Tracker or an Activity Filter, as follows:
e select New > Activity Group Calendar Feed as shown below:
My Homepage  Accounts Activities Pipeline »

User Homepages = Guest, Joe O = MyCals - Calendar Profile
Edit Wiew Security Wizards
General System

Mame: MyCals
Dre=cription:

Calendar Feeds

| Q, Mew Edit View
1M [] Hame = Description iCal Fead
test Activity Grou p’@endm Feed
Activity Filter Cenendar Feed




openCRX Admin Guide - Version 2.5.2 Groupware Services

e select an activity group and enter at least a name for this feed and
mark it as active:

Untitled - Activity Group Calendar Feed

General  System

Mame: Bugs and Features Active:

Dezcription:

Color font; Color background: #CCF420

Activity group: Bugs + Features Q

Save||Cancel

e click [Save]
e optionally, add more feeds (you can also add additional feeds later)

9.3.6.2 CalDAV Configuration of Thunderbird/Lightning and Sunbird

Thunderbird 2.0 with the Lightning add-on (at least version 0.9) is a fully-
fledged calendar client and offers virtually the same calendaring functionality
as the stand-alone calendar client Sunbird (at least version 0.9). Creating a
remote calendar (hosted on your openCRX server) is rather straightforward:

start Thunderbird/Lightning or Sunbird

select the menu File > New Calendar

in the dialog window Create New Calendar you select On the Network
then you select CalDAV

enter a CalDAV URL into the field Location;

example: the user guest would connect to this openCRX homepage with the URL
http://127.0.0.1:8080/opencrx-caldav-CRX/CRX/Standard/userhome/guest
See chapter 9.3.2 Calendar Selectors for information on CalDAV URLs

give your calendar a name and pick a color of your choice
that's it — you are connected to openCRX

9.3.6.3 CalDAV Configuration of MS Outlook

Outlook does not support CalDAV. There are third-party extensions you might
want to try. Some of them are listed at
http://wiki.davical.org/w/CalDAV_Clients/Outlook.

See also http://www.opencrx.org/opencrx/2.4/0utlook_ICS_VCF_adapter.htm



http://www.opencrx.org/opencrx/2.4/Outlook_ICS_VCF_adapter.htm
http://www.opencrx.org/opencrx/2.0/Outlook_ICS_adapter.htm
http://wiki.davical.org/w/CalDAV_Clients/Outlook
http://www.mozilla.org/projects/calendar/sunbird/
http://www.mozilla.org/projects/calendar/lightning/download.html
http://www.mozilla.com/en-US/thunderbird/
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9.3.6.4 CalDAV Configuration of iPhone

With iPhone 0S3.0+ you can connect to any openCRX calendar collection as

follows:
e connect to openCRX navigate to the calendar collection you want to
connect your iPhone
e start the wizard Calendar / vCard Connection Helper:
My Homepage  Accounts Activities Pipeline »
User Homepages = Guest, Joe O = MyCals - Calendar Profile
Edit View Security Wizards
| calendar  vCard Connection Helper... |
General System
Name: MyCals
De=scription:
e this wizard “calculates” the CalDAV URL required to connect:
Role of rezource: Calendar ]
Bazed on: CalDAV Calendar Profile [?]
Calendar Profile: MyCals [Guest, Joe O /guest] [+
Calendar Cptlons
Generate: activities (from Activities) (v
Type: CalDAV [w]
Hint you can 52t MaxActivities inme Component-Configuration of e 1CalSenet (detaul ks 500
(_U RL: hitp:iidemo.opencrx.org/opencrx-caldav-CRXIC FLX.-'Etﬂndﬂrda‘u&&n‘gu&st.-'prufil&a'r-hfcﬂls]
e copy the above URL (you'll need to paste it later)
e on your iPhone home screen, tap the icon Settings
e ap on Mail, Contacts, Calendars gulDenaeCHES 311 EZER
Enter your CalDAV account information.
® tap on Add Account... — CalDAV  e—
e tap on Other
Server demo.opencrx.org
e tap on Add CalDAV Account .
e and then enter or paste the CalDAV URL into  UserName guesi
the field Server and populate the fields User Password esses
Name and Password as show below: -
. ) ) Description demo.opencrx.org
e tap [Next] to verify the account information

If you get a message “"Cannot Connect Using SSL"” tap [No] to
move on to the next screen where you can enter the connection
e details.
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e verify/complete your subscription information as follows:

_allOrangeCH = 13:29 64% F

Server verify the server name
User Name your openCRX user name Account o
Password your openCRX password Y o nronTeRion
Description any text you like Senier  domoapensnoly
. U N t
Use SSL if you use SSL, set to [ON], | o e 9es
otherwise [OFF] Password eeeee
Port port number (Tomcat) Description demo.opencrx.org
Account URL the CalDAV URL
Advanced Settings >
' Delete Account
_allOrangeCH = 13:29 64% [F

[ demo.opencrx.... | Advanced Settings |

Use SSL | | oFF |
Port 80

Account URL nhttp:/demo.opencrx.org...

e if you use SSL in combination with a self-signed certificate, you will get a
message Unable to Verify Certificate --> tap Accept

e if everything works out, you can tap Save to store the settings and your
calendar will be available in the Calendar App from the iPhone's home
screen

Unfortunately, iPhone OS3.0+ does not support Tasks over CalDAV,
i.e. you will only see openCRX Activities of type VEVENT in your

Important oy one calendar.

9.3.6.5 Deleting Events

The CalDAV protocol supports deletion of events/tasks. openCRX honors such
requests, although the respective activity is disabled and not deleted. If you
absolutely want to delete an activity you can do so with the standard GUI.
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9.3.7 Calendaring / Timeline

Timeline is an extremely interesting DHTML-based AJAX widget for visualizing
time-based events. It is like Google Maps for time-based information. A live

example is available at http://www.simile-widgets.org/timeline/

» STMILE. » Timeline

Timeline

Timeline is a DHTML-based AJAXNy widget for visualizing
time-baszed events. It iz like Google Maps for time-bazed
information. Below is a live example that vou can play with, Pan
the timeline by dragging it herizontally,

@ Man with seizure in front of TSED @ wita
sizing motorcade arsa @ Kennedy shot
3 Man with rifie seen in TSED @ washington D.C.'s |
} TSED sixth flcor empty @ Dzwald leaves -
) Oswald seen havine lunch @7
i@ Police radio for ambulance
@ williame keft sth floor
@ Officers ordered to m
1 1 1 1
| | | |
:I
& 1
n |
T L
2 |
F 1
= (11D 12:00 1300

Simile

® Browse= the Cod=
® [snym Tracker

m

LATED PROIJECTS

imeplot
habat

a8 T
=

Figure 54: Timeline visualizes time-based events

CrxObjects with sets of activities typically feature the wizard Timeline. Simply
call that wizard to construct a timeline to visualize activities right in your

browser:
@& guest, - My Homepage

File Edit Find View  Actions Security  Wizards

Timeline..
General | Charts |Options | System

Groupware Services
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9.4 Mailstore / IMAP

Instead of offering platform specific plugins for a multitude of mail clients like
MS Outlook, MS Outlook Express, Thunderbird, Evolution, Eudora, EIm, etc.
openCRX features a platform neutral IMAP adapter (get more information
about IMAP or read what Wikipedia is saying about IMAP). The advantages of
such a standardized IMAP adapter are:

e works with any IMAP client (including your favorite one)

e no clumsy installation of plugins, i.e. you can get this to work on your
company's laptop regardless of how “hardened” and locked down the
system is

e supports single message import and bulk import

imports headers, body, and attachments
e automatically creates references to sender and recipient(s) if the
respective e-mail addresses are present in openCRX

In a nutshell this means that you can use any IMAP client to connect to
openCRX and view openCRX EMailActivities. openCRX activity groups are
mapped to IMAP folders. The folders contain openCRX EMailActivities.

Viewing/exporting of EmailActivities is always possible, creating/updating of
EmailActivities requires that an E-Mail Activity Creator is defined for the
respective Activity Group, and deleting of EmailActivities is not supported.

If you move an e-mail message from a non-openCRX IMAP folder to
) an openCRX IMAP folder and the target folder does not have a valid

Waminu  F_Mail Activity Creator defined, openCRX will not be able to create an
EMailActivitiy in that folder. Due to the move operation the message
is deleted from the source folder and your e-mail message is lost.
Hence, it is good practice to copy (and not move) e-mails to
openCRX IMAP folders. Only after verifying that the EMailActivitiy was
actually created by openCRX in the target folder should you delete (if
necessary) the message from the source folder.

E-mail addresses should be unique!

mporiam LT You import e-mails into openCRX with the IMAP Adapter, openCRX
tries to match sender and recipients based on e-mail addresses. For
obvious reasons, this will produce unexpected (if not undesired)
results if e-mail addresses in openCRX are not unique.

You can test your openCRX database for duplicate e-mail addresses
with the following query:

SELECT email_address, count(*)
FROM OOCKE1_ADDRESS
GROUP BY email_address HAVING count(*) > 1



http://en.wikipedia.org/wiki/IMAP
http://tools.ietf.org/html/rfc3501
http://en.wikipedia.org/wiki/List_of_email_clients
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E-mail address UNASSIGNED.

If the openCRX IMAP Adapter is not able to link a sender/recipient
address to an existing e-mail address in openCRX, the adapter can
assign such senders/recipients to an account of your choice. Simply
add an e-mail address UNASSIGNED to the desired account as shown
below:

General

E-mail address: UNASSIGNED

Format: NIA

Type: NIA

Usage: Main address: F
Building:

Figure 55: E-Mail Address UNASSIGNED

In order to detect missing e-mail addresses (and then enter them and
reassign the respective e-mail activities) you can simply work through
the activities assigned to the account with the above e-mail address.

The following information is required to connect an IMAP client to openCRX:

Host IP address or host name of openCRX Server
Examples: localhost, 127.0.0.1, myCrxServer.myCompany.com, etc.
Port 1143 (note that the IMAP standard port is 143)

User name <login principal hame>@<Segment>

Example: guest@Standard

Password |principal's openCRX password

Important

The openCRX IMAP adapter does not support SSL, i.e. you should use
this feature on secured networks only (Intranet, VPN, ...).
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9.4.1 Configuring the openCRX IMAP Port

The openCRX IMAP port is by default set to 1143 (to avoid conflicts with other
IMAP daemons listening on the IMAP standard port 143). You can change this
configuration in the file web.xml located in the directory
opencrx-core-CRX\opencrx-imap-CRXWEB-INF\

Look for the the param-name port.

If you build your own EARs you can change the openCRX LDAP port in your
project's file build.properties (imap.listenPort) or directly in your build.xml.

9.4.2 Configuring the IMAP Maildir Cache

For increased performance the openCRX IMAP Adapter works with a cache. The
location of this cache, the so-called Maildir, can be set as a JAVA_OPTS.

You can reset the cache by deleting it. The openCRX IMAP Adapter
will recreate the cache automatically. Hence, you might want to
L delete the cache when restarting Apache Tomcat.

9.4.2.1 Maildir Configuration with Apache Tomcat

Add the following line to your JAVA_OPTS in your Tomcat start batch file (e.qg.
tomcat.bat, run.bat, run.sh, etc.):

Listing 11: Set org.opencrx.maildir for Apache Tomcat

set JAVA OPTS=%JAVA OPTS$% -Dorg.opencrx.maildir="$CATALINA HOME%\maildir"
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9.4.3 IMAP Configuration of Thunderbird

The following information is required to configure an IMAP account:

Email account

<login principal name>@<Segment>
Example: guest@Standard

Password

openCRX password of the respective principal

Your name

<login principal name>@<Segment>
Example: guest@Standard

Email Address

your e-mail address
Example: guest@mycompany.com

Type of server

IMAP

Incoming Server
Outgoing Server

name or IP address of your openCRX server
Example: 127.0.0.1

Port

1143

Incoming User Name

<login principal name>@<Segment>
Example: guest@Standard

= guest@Standard

Account Settings
=l-¢= Inbox
=L O =] gljlest@Standard ~| Settinas
2 [} Standara i-Server Settings
S tracke Copies &Folders Server Type:  IMAP Mail Server
| admin-Standard~Private Composition & Addressing Server Mame: | 127.0.0.1 Port: | 1143 | Def
|, guest~Private Offline & Disk Space User Name: quest@Standard
|, shared Junk Settings
OpenPGP Security Security Settings
Return Receipts Use secure connection:
Security @ Mever () LS, ifavailable (O Ts (O ssL
ha |:| |Jse secure authentication
[ Add Account. ..

Figure 56: Thunderbird IMAP Configuration

If you move an e-mail message from a non-openCRX IMAP folder to
)} an openCRX IMAP folder and the target folder does not have a valid

Waminu  F-Mail Activity Creator defined, openCRX will not be able to create an

EMailActivitiy in that folder. Due to the move operation the message

is deleted from the source folder in your IMAP client and your e-mail

message will be lost.

Hence, it is good practice to copy (and not move) e-mails to

openCRX IMAP folders. Only after verifying that the EMailActivitiy was
actually created by openCRX in the target folder should you delete (if
necessary) the message from the source folder.
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9.4.4 IMAP Configuration of MS Outlook
The following steps are required to configure MS Outlook 2007 for LDAP:

Email account

<login principal name>@<Segment>

User Name Example: guest@Standard
Password openCRX password of the respective principal
Your Name <login principal name>@<Segment>

Example: guest@Standard

E-mail Address

your e-mail address

Example: guest@mycompany.com

Account type

IMAP

Incoming mail server
Outgoing mail server

name or IP address of your openCRX server

Example: 127.0.0.1

Incoming Port

1143

Incoming User Name

<login principal name>@<Segment>
Example: guest@Standard

Mail Folders
2] All Mail Items

=] ‘E‘-ﬁ Personal Folders
@ Deleted Items
L.# Drafts [1]
L] Inbox
L@ Junk E-mail
= Cutbox
L= sent Items
4 LA Search Folders
= &4 guest@mycompany.com
= [ Inbox
= 3 crx
=l [_J Standard
= [ tracker

b

|1 admin-Standard~Private

|1 guest~Private

3 shared
4 L& Search Folders

E-mail Accounts

‘You can add or remove an account, You can select an account and change its settings.

E-mail

Data Files | RSS Feeds

SharePoint Lists

of New... ‘3 Repair... ESF Change...

Mame
guest@mycompany.com

Type

Internet Calendars | Published Calendars | Address Books

X Remove

IMAP/SMTP (send from this account by default)

Change E-mail Account

o~ Mail

ﬁ Calendar

8=| Contacts

SZ Tasks

o | Ca (8] ~

Internet E-mail Settings

Each of these settings are required to get your e-mail account working.

User Information
Your MName:

E-mail Address:
Server Information
Account Type:

Incoming mail server:

Qutgoing mail server (SMTF):

Logon Information
User Name:

Passward:

quest@standard

guest@mycompany.com

127.0.0.1

127.0.0.1

guest@5tandard

ggggg

Remember password

[]Reguire logon using Secure Password Authentication (SPA)

Test Account Settings

After filing out the information on this screen, we
recommend you test your account by dicking the
button below. (Requires network connection)

Test Account Settings ... ]
More Settings ...
[ Mext = l [ Cancel

]

Figure 57: MS Outlook IMAP Configuration



mailto:guest@Standard

openCRX Admin Guide - Version 2.5.2 Groupware Services

T
arning

If you move an e-mail message from a non-openCRX IMAP folder to
an openCRX IMAP folder and the target folder does not have a valid
E-Mail Activity Creator defined, openCRX will not be able to create an
EMailActivitiy in that folder. Due to the move operation the message
is deleted from the source folder of your IMAP client and your e-mail
message will be lost.

Hence, it is good practice to copy (and not move) e-mails to
openCRX IMAP folders. Only after verifying that the EMailActivitiy was
actually created by openCRX in the target folder should you delete (if
necessary) the message from the source folder.
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10 openCRX is a REST Service (Web Service)

The openCRX REST servlet allows easy 3rd party integration with openCRX.
The full functionality of the openCRX API can be accessed via REST requests,
i.e. you can use openCRX as a REST Service.

See http://code.google.com/p/rest-client/ for a REST client.

Sample REST requests are available from
http://www.opencrx.org/opencrx/2.3/new.htm#REST

You might also want to look at the following Wiki page:
https://sourceforge.net/apps/trac/opencrx/wiki/Sdk24.Rest



https://sourceforge.net/apps/trac/opencrx/wiki/Sdk24.Rest
http://www.opencrx.org/opencrx/2.3/new.htm#REST
http://code.google.com/p/rest-client/
http://www.xfront.com/REST-Web-Services.html
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11 Data Import/Export

There are many ways of importing data (from other systems into openCRX)
and exporting data (from openCRX to other systems). Generally speaking,
there is no best way of doing imports/exports because depending on how
much weight you put on the pros and cons of the various methods you may
come to a different conclusion. Some issues to consider are:

e one-time import/export vs. multiple imports/exports
e file-based/batched vs. connection-based/real-time
e allow manual process steps vs. fully automated

In this chapter we will cover some of the basic options you can choose from,
but there are obviously other (and sometimes better) options to consider.

While it may be tempting to connect to the openCRX database for
“quick and dirty” imports/exports, you should really consider using

"o the openCRX API. On the one hand, importers/exporters accessing
the database directly are bypassing openCRX security (this is
actually more of a warning than a tip...). On the other hand, the
openCRX database schema is subject to change (whereas the
API is stable).

11.1 Importing Data into openCRX

The task of importing data is handled by importers. In principle, you can
import almost anything into openCRX, it’s really only a matter of writing an
appropriate importer.

You must ensure that (legal) values are assigned to all mandatory
(i.e. non-optional) attributes of openCRX objects created/updated
Waminu  quring the import; in particular, all code attributes are mandatory!

The Open Source distribution of openCRX includes importers for vCard (see
Importing vCard Files)and iCalendar files (see Error: Reference source not
found) in addition to the XML importer.

11.2 Importing XML Files

You can import virtually any data into openCRX as long as you provide it in the
form of schema-compliant XML files. The openCRX schema files can be found
in the file opencrx-kernel.jar (unzip and look for xmi subdirectories).
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Alternatively, you can export example objects as XML files and look at the
produced XML files (although the generated XML file also contains all the
derived and optional attributes; hence, you will have to prune the generated
XML file before you can use it as a template).

Some of the configuration information and data provided with openCRX are
also provided in the form of XML files and imported during system setup (e.g.
units of measurement are loaded from opencrx-core-CRX\opencrx-core-
CRX\WEB-INF\config\data\ Root\101_uoms.xml).

An XML import from a third party system might typically involve the following
steps:

3vd party
System
|
XML Files XSLT XML Files
t—> Processor .. {compliant with
{e.g. Xalan) openCRX schema)
openCRX

Figure 58: XML import from 3™ party system - overview

You can import schema-compliant XML files with the following methods:
e Interactive / on-demand
Navigate to your user home and execute the operation File > Import:

guest@standard

opencrx

en LS

My Homepage | Accounts  Activities Pipeline »
! @ User Homepages - Guest, Joe O - My Homepage

File Edit Find View Actions Security Wizards

Import...
Save Aszsigned Activities Q iCal...

em

Contact: Guest, Joe O

Figure 59: Interactive import of XML Files

Click on the button [ Browse..  and navigate to XML file to be imported.
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Next you click OK to to start the import. Please note that this method is
very suitable for small XML files and on-the-fly imports. If you are
dealing with larger XML files, however, you should consider the bulk
import described below.

e Bulk Import

Use the bulk import for large XML files or if you need to import multiple
XML files in an automated fashion. Put your XML file(s) into the following
directory (you might have to expand the EAR file to do so):

opencrx-core-CRX\opencrx-core-CRX\WEB-INF\config\data\<SegmentName>

where <SegmentName> can be Root, Standard, or whatever your
Segment is named.

Next you login as openCRX Root administrator (admin-Root) and execute
the operation View > Reload. Click Yes to start the operation.

OpenCl"X admin-Root@Root Root

en LS

Administration | UOMs Codes  Security Realm  Security Policies  Security Subjects

, ™o Administration

Edit WView Actions Wizards

Confit pejpad. o ‘

r7] v = New Edit View

Figure 60: Interactive import of XML Files

Once the import is started you can close the browser, i.e. there
is no need to keep the session alive until the import is

Tin completed. Some information regarding the progress of the
import is written to the console.

In case you have data dependencies between/among your XML
files (e.g. some files contain Contact data while others contain

Tin address data which is composite to Contact data) you should
make sure that parent data are imported before child data
gets imported. This should be relatively easy to achieve as XML
files are imported in alphabetical order.
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11.2.1 Importing Excel Files (> openCRX Accounts)

You can directly import Excel Sheets that contain field names in the first row
and then data in the rows 2, 3, .... An example sheet is shown below:

L@ Microsoft Excel - acct.xls
@ File Edit View Insert Format Tools Data  Window Help Adobe PDF
0 EEH RS T B % B S0 o8 8] L) 0[] 0o
i MS Sans Serif -0 - B J U|IEE=E=M|%¥ S % » sl EE| . D
315 - fe
K| L | b | M | 0 | =
1 |Title FirstName MiddleName LastName SuffixBusinessStreet
¢ |Mr. | Tim Thunderhird Jones Jr. bAr Tirm J. Thunderkbirdf&4 California Awve.
3 Aaron Thunderbird Aaronsen
4 |hr. Roger Thunderbird Fabhit
5 |kr. | Jeff Thunderbird Dude
b Fahitts Clock Shop AG

Figure 61: Import Accounts from Excel Sheet — Sample Excel Sheet

The following field attributes are supported:

Field Name openCRX Attribute / Description

DTYPE (optionally) provide the type of openCRX account; acceptable
values are: CONTACT, LEGALENTITY, GROUP, and
UNSPECIFIEDACCOUNT

TITLE Contact.salutationCode

FIRSTNAME Contact.firstName

MIDDLENAME Contact.middleName

LASTNAME Contact.lastName

ALIASNAME Contact.aliasName

NICKNAME Contact.nickName

SUFFIX Contact.suffix

COMPANY depending on the type of imported Account, the value is
mapped to one of the following attributes:
- Contact.organization
- LegalEntity.name
- Group.name
- UnspecifiedAccount.name
if the imported account is of type Contact and a matching
account with name equal to COMPANY is found, then the
imported Contact is made a member of the matching account;
furthermore, COMPANYROLE is mapped to
Member.memberRole and JOBTITLE is mapped to
Member.description

JOBTITLE Contact.jobTitle
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DEPARTMENT Contact.department
BIRTHDAY Contact.birthdate

the following formats are recognized:

dd-MM-yyyy, dd-MM-yy, MM/dd/yyyy, MM/dd/yy
HOMEPHONE Account.PhoneNumber.fullNumber (with usage = home)
HOMEPHONE?2 Account.PhoneNumber.fullNumber (with usage = other)
HOMEFAX Account.PhoneNumber.fullNumber (with usage = fax home)
HOMEADDRESSLINE Account.PostalAddress.postalAddressLine (usage = home)
HOMESTREET Account.PostalAddress.postalStreet (usage = home)
HOMECITY Account.PostalAddress.postalCity (usage = home)
HOMEPOSTALCODE Account.PostalAddress.postalCode (usage = home)
HOMESTATE Account.PostalAddress.postalState (usage = home)
HOMECOUNTRY or Account.PostalAddress.postalCountry (usage = home)
HOMECOUNTRYREGION
BUSINESSPHONE Account.PhoneNumber.fullNumber (with usage = business)
BUSINESSPHONE?2 Account.PhoneNumber.fullNumber (with usage = other)
BUSINESSFAX Account.PhoneNumber.fullNumber (with usage = fax business)
BUSINESSADDRESSLINE Account.PostalAddress.postalAddressLine (usage = business)
BUSINESSSTREET Account.PostalAddress.postalStreet (usage = business)
BUSINESSCITY Account.PostalAddress.postalCity (usage = business)
BUSINESSPOSTALCODE Account.PostalAddress.postalCode (usage = business)
BUSINESSSTATE Account.PostalAddress.postalState (usage = business)

BUSINESSCOUNTRY or
BUSINESSCOUNTRYREGION

Account.PostalAddress.postalCountry (usage = business)

MOBILEPHONE Account.PhoneNumber.fullNumber (usage = mobile)

EMAILADDRESS Account.EMailAddress.emailAddress (usage = business)

EMAIL2ADDRESS Account.EMailAddress.emailAddress (usage = home)

EMAIL3ADDRESS Account.EMailAddress.emailAddress (usage = other)

WEBPAGE Account.WebAddress.webUrl (usage = business)

ASSISTANTSNAME if matching account with full name equal to ASSISTANTSNAME
is found, then the matching account is made a member of the
imported account; furthermore, ASSISTANTSNAMEROLE is
mapped to Member.memberRole

MANAGERSNAME if matching account with full name equal to MANAGERSNAME is
found, then the imported account is made a member of the
matching account; furthermore, MANAGERSROLE is mapped to
Member.memberRole

NOTES Account.description
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CATEGORIES

Account.category

you can provide a semicolon-separated list of categories (e.g.
Business;Birthday;Xmas) and the importer will add all missing
items to the list of categories contained in Account.category

The field names match up with those produced by MS Outlook if you

export Contacts from MS Outlook to an Excel Sheet:

|

Create a file of type:

Comma Separated Values (DOS)
Comma Separated Values (Windows)
Microsoft Access

Personal Folder File {,pst)
Tab Separated Values (DOS)
Tab Separated Values (Windows)

[ <sck || text> | [ concd |

The Importer produces a detailed on-screen report with clickable links and a
summary report stating the total number of created/updated accounts:

UPDATED [Contact]: Aaronsen, Aaron Thunderbird [/ (@ openmdx org. opencn.kernel. account1/provider CR/segment/Stan

Roww

0004 Fa s

UPDATED [Contact]: Rabbit, Roger Thunderbird [xri.//{@openmdx®org. cpenonckernel. account1/provider CRM segment’Standar

Rowr
0005

UPDATED [Contact]: Dude, Jeff Thunderbird [xri://{@openmdx org. openox kernel account/providen’'CR/segment'Standard/a:

Rowr .
0006 LegalEntity

Sheet: Contacts | data lines read: 5

Dty pe created updated
Contact 1 3
Group a 1
LegalEntity 1 1
UnspecifiedAccountd 1

Figure 62: Import Accounts from Excel Sheet — Import Report

Before you launch an import of thousands of accounts, verify the
structure of your Excel sheet with a few lines/accounts only.
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11.2.2 Importing vCard Files (- openCRX Contacts)

vCard is file format standard for personal data interchange, specifically
electronic business cards (additional information is for example available from
http://en.wikipedia.org/wiki/VCard).

These are the steps to import a vCard file:

e click on the provider Accounts and navigate to an existing Contact (or
create a new one)

e select the operation File > Import vCard to unhide the import dialog:
My Homepage @ Accounts | Activities Pipeline »

1 Accounts = Guest, Joe O - Contact

File Edit View Tools Actions Security Wizards

Import vCard. .. Import wCard »

Sawve as vCard...

New Contact...
Export... Language: English (en_US5) W

Export Advanced... .
them: Browse_

Firzt Name:

Middle Name:

Last Name:

Figure 63: Operation vCard Import

e select the appropriate language
e click the Browse button and navigate to the vCard file you want to import
e click the OK button to start the import operation

11.2.3 Importing E-Mails

Please refer to the Chapter 8 E-mail Services, in particular chapter 8.3.1
Import E-mails.

11.2.4 Other Options

There are various other options to consider. You could for example develop a
custom-tailored JSP Wizard to import data on demand or on a regular basis
(e.g. controlled by the openCRX WorkflowController).

Sometimes it is more appropriate to develop a specific openCRX client to
handle imports, and in a typical enterprise class environment you will probably
consider developing adapters to connect/integrate openCRX with 3™ party
systems on a real-time basis.
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11.3 Exporting Data from openCRX

The task of exporting data is handled by exporters. The Open Source
distribution of openCRX includes exporters for vCard and iCalendar files in
addition to the XML exporter.

This allows you to export contacts and meetings/sales visits or any other
object from openCRX. vCard and iCalendar files can be imported by a large
variety of other applications, including Microsoft Outlook. This chapter shows
how to export data.




openCRX Admin Guide - Version 2.5.2 Data Import/Export

11.3.1 Exporting XML Files

Navigate to the object to be exported as XML file and execute the operation
File > Export Advanced as shown below:

Export Advanced b
Reference filter: customen;position;salezRepaddress
MIME type: textixml L

Figure 64: Exporting SalesOrder as XML File

In order to better control which additional objects (composites, referenced
objects, ...) the XLM exporter should export together with the object loaded in
the Inspector, you can (optionally) provide a reference filter (optionally with
a navigation level). By default, only the current object will be exported. If
you provide - for example when exporting a sales order — customer;address
as a reference filter, the customer and all referenced addresses will be
exported together with the main object. If you export a contact and provide
the reference filter member[1] you will get direct members of this contact.

If the export is successful the exporter will terminate with status OK and you
will be provided with a link to the file Export.zip containing the raw data:

- WinZip - Export.zip g@
File Actions Options Help
2 9 0y (5.a &2 E=
Mew Cpen Favorites Add Extract Encrypt View CheckCOut  Wizard
MName Type Maodified Size | Ratio | Packed | Path

Emdata-0.xml ; XML Document  10-Jul-2008 12:34 13,600 85% 2,090

[Emhdata-1.xml XMLDocument 10-Jul-2008 12:34 7,166 80% 1,424
[mhdata-2xml ¥MLDocument 10-Jul-2008 12:34 7,048 79% 1,498

Selected 0 files, 0 bytes Total 3 files, 23KE 6 ';:I
Figure 65: XML Exporter provides XML data file and code tables as ZIP file

The openCRX ICS Adapter can also export iCalendars in XML format:

ICS URL (to get XML file with authentication):
http://<crxServer>:<Port>/opencrx-ical-<Provider>/activities
?id=<Provider>/<Segment>/<Calendar Selector>&type=xml

Example:
http://localhost:8080/opencrx-ical-CRX/activities?id=CRX/Standard/tracker/main&type=xml

See chapter 9.3.2 Calendar Selectors for information on how to

. construct calendaring URLs.
n
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11.3.2 Exporting Data to MS Excel / Open Office Calc Files

Navigate to the object to be exported as spreadsheet file and execute the
operation File > Export Advanced as shown below:

Reference filter: customer;position;salesRep;salesRepl:*/address
MIME type: application'x-excel Rl

o o=

Figure 66: Exporting SalesOrder as Spreadsheet File

In order to better control which additional objects (composites, referenced
objects, ...) the XLM exporter should export together with the object loaded in
the Inspector, you can (optionally) provide a reference filter. By default, only
the current object will be exported. If you provide - for example - :*/:* as a
reference filter, all composites up to 2 levels deep will be exported together
with the main object (this should be sufficient for most use cases). You can
also provide a reference filter to dereference and export referenced objects like
the customer or the salesRep of a sales order.

If the export is successful the exporter will terminate with status OK and you
will be provided with a link to the file Export.xls containing the raw data:

f‘, Export - OpenOffice.org Calc [Z]@

File Edit View Insert Format Tools Data Window Help

B-cHe R RSR Y i bR -dio-0- BUL O ]
3 W P Ml @ B JU| ====H|5%55%™ B
ALIVL v fw = = |

1 |Risd

2 [xrtxno@openmd+1 0 org-opencrckernelcontract1:SalesOrder 3 2

3 |xi-mxr@openmd+1k 1

4 |xritxi-@openmae+1r 2 =
] \Saleg{)rderfpusiﬁun { Account / U_(_ )I .
Sheet 1/3 || PageStyle_SalesOrder || 100% STD = Sum=0

Figure 67: Exported Spreadsheet File

Based on such spreadsheet files end-users can easily create reports or do
some ad-hoc data analysis without the need to know anything about Java or
writing JSPs. The standard distribution of openCRX includes various example
reports based on this technology.
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11.3.3 Exporting openCRX Contacts (- vCard Files)

These are the steps to manually export a contact to a vCard file:

navigate to the contact you want to export

click on the tab Account

select the contents of the field vCard and copy it to an empty text file
save the text file with any name and extension “vcf”, e.g. contact.vcf:
viZard: i i

There is also a wizard vCard.jsp available which allows you to export
individual accounts or batches of accounts as vCards.

Navigate to an Account and select File > Save as vCard to start the export:

My Homepage | Accounts = Activities Pipeline »
1 Accounts = Rabbit, Roger Thunderbird - Contact

File Edit View Tools Actions Security Wizards

Import vCard...

Save as vCard... o
Mew Contact... Q

Export. .. Mr.

unt|  System

Export Advanced...

Figure 69: Export individual Contact as vCard with Wizard

In order to export multiple accounts as vCards, create an Account Filter that
selects the desired accounts and then navigate to this Account Filter. Select
File > Save Filtered Accounts as vCard:

My Homepage @ Accounts | Activities Pipeline =»
T Accounts = TB - Account Filter

File Edit View Tools Actions Security Wizards
Save Filtered Acoounts as vCard..

Export...

Export Advanced...

Name: TB

Dezcription: te=t fiter for Thunderbird Add-on

Figure 70: Export multiple Contact as vCards with Wizard
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11.3.4 Exporting openCRX Meetings (- iCalendar Files)

These are the steps to export an individual activity (e.g. a meeting or a sales
visit) to an iCalendar file:

e navigate to the meeting (or sales visit) you want to export

e click on the tab Details

e select the contents of the field iCal and copy it to an empty text file

e save the text file with any name and extension “ics”, e.g. meeting.ics:

iCal BEGIN:VCALENDAR
PRODID://OPENCRY!
VERSION:2

EIE' 1”] VEW

MONSGML Version 1/EM

I-ILI IE [ "'TE ::-:l.
-MODIFIED:20080710T1023272
VIE-200807 ]||T]|| 3277

Figure 71: Exporting Meeting / Sales Visit as iCalendar File

There is also a wizard iCal.jsp available which allows you to export individual
activities or batches of activities as iCals.

Navigate to an Activity and select File > Save as iCal to start the export:

My Homepage  Accounts | Activities Pipeline =»
*= Activities = 1000120: Time test - Task

File Edit WView Actions Security Wizards
Imnport iCal...

Save as iCal...

Export. .. %

Export Advanced... TIme test

Figure 72: Export individual Activity as iCal with Wizard

In order to export multiple activities as iCals, navigate to an Activity Group
(Activity Tracker, Category, Milestone), to an Activity Filter (or to any other
object that features a list of assigned activities like Userhome, Account) and
then select File > Save Filtered Activities as iCal (Save Assigned Activities as
iCal).
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11.3.5 Exporting E-Mails

Please refer to the Chapter 8 E-mail Services, in particular chapter 8.2.2
Export E-mails.

11.3.6 Other Options

There are various other options to consider. You could for example develop a
custom-tailored JSP Wizard to export data on demand or on a regular basis
(e.g. controlled by the openCRX WorkflowController).

Sometimes it is more appropriate to develop a specific openCRX client to
handle exports, and in a typical enterprise class environment you will probably
consider developing adapters to connect/integrate openCRX with 3rd party
systems on a real-time basis.

If you have a REST client available, then exporting via REST is also a very
viable option.
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12 Customizing openCRX

Please refer to the guides available at http://www.opencrx.org/documents.htm
for detailed information regarding UI customization and localization.

12.1 Managing Locales

The default installation of openCRX activates all locales that are included in the
Open Source distribution. The openCRX administrator may wish to deactivate
certain locales from the locale list. This chapter shows how you can achieve
this.

The locale list is contained in the file
opencrx-core-CRX\opencrx-core-CRX\WEB-INF\web.xml

Look for the section <!-- locales --> to find a list of available locales:

Listing 12: Locales in web.xml

<!-- locales -->

<init-param>
<param-name>locale[0]</param-name>
<param-value>en US</param-value>

</init-param>

<init-param>
<param-name>locale[l]</param-name>
<param-value>de CH</param-value>

</init-param>

<init-param>
<param-name>locale[2]</param-name>
<param-value>es MX</param-value>

</init-param>

You can deactivate locales by simply commenting them out. The following
example shows how to deactivate the locale de_CH.

Listing 13: Activating/Deactivating Locales in web.xml

<!-- locales -->

<init-param>
<param-name>locale[0]</param-name>
<param-value>en US</param-value>

</init-param>

<=

<init-param>
<param-name>locale[l]</param-name>
<param-value>de CH</param-value>

</init-param>

-—>

<init-param>

Please note that you must not deactivate the base locale (that is the
locale with the id 0, typically en_US) as the base locale contains a lot
of customizing information not present in other locales.

1T
arminn
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12.2 Managing Packages

The default installation of openCRX activates all packages that are included in
the Open Source distribution. The openCRX administrator may wish to
deactivate certain packages if they are not used. This chapter shows how you
can achieve this.

The package list is contained in the file
opencrx-core-CRX\opencrx-core-CRX\WEB-INF\web.xml

Look for the section <!-- Admin --> to find a list of available packages:

Listing 14: Packages in web.xml

<!-- Admin -->

<init-param>

<param-name>rootObject [0]</param-name>
<param-value>xri:Q@openmdx:org.opencrx.kernel.adminl/provider/CRX/segment/${SEGMENT}</param-value>
</init-param>

<!-- Home -->

<init-param>

<param-name>rootObject [1]</param-name>
<param-value>xri:Q@openmdx:org.opencrx.kernel.homel/provider/CRX/segment/${SEGMENT}/userHome/$ {USER}</param-value>
</init-param>

<!-- Accounts -->

<init-param>

<param-name>rootObject [2]</param-name>
<param-value>xri:Qopenmdx:org.opencrx.kernel.accountl/provider/CRX/segment/${SEGMENT}</param-value>
</init-param>

You can deactivate packages by simply commenting them out. The following
example shows how to deactivate the package depot1:

Listing 15: Activating/Deactivating Packages in web.xm/

</init-param>
<!-- Depots -->
<[ ==
<init-param>
<param-name>rootObject [6]</param-name>
<param-value>xri:Q@openmdx:org.opencrx.kernel.depotl/provider/CRX/segment/${SEGMENT }</param-value>
</init-param>
-—>
<!-- Documents -->
<init-param>
<param-name>rootObject [6]</param-name>
<param-value>xri:Q@openmdx:org.opencrx.kernel.documentl/provider/CRX/segment/$ {SEGMENT}</param-value>
</init-param>
<!-- Buildings -->

Please note that you must renumber all the packages listed after the
package you deactivated so that the package numbering does not
have any gaps (i.e. package numbering starts at 0 and it must
be consecutive).

It is also possible to change the order of the active packages by
renumbering them. However, you must still ensure both that the
Tin numbering starts at 0 and that the numbering is consecutive.
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12.2.1 Enabling/Disabling Root Menu Entries

Individual user can enable/disable root menu entries with the wizard User
Settings (available on a user's Homage):

My Homepage | Accounts  Activities Pipeline »
it User Homepages = Guest, Joe O - My Homepage

File Edit Find View Actions Security Wizards

Gene tions || System
User Settings... : o

Contact: Guest, Joe O

Figure 73: Launch Wizard User Settings

Once the wizard has loaded, uncheck entries you don't need:

Root Menu
Is Active
Accounts:
Activities:
Pipeline:
Products:
Depots:
Documents:
Buildings:
Forecasts:
UOMSs:
UOMs (Roat):
Codes:
Woarkflows:
User Homepages:
Security Realm:
History:

Figure 74: Wizard User Settings — enable/disable Root Menu Entries

Please note that entries corresponding to packages disabled by the
openCRX administrator cannot be enabled with this wizard. Packages

Important  isabled in web.xml are not available at all!

Depending on the width of your screen you can adjust the nhumber of
items shown as tabs in the top-level navigation in the same wizard
Tio (fewer items for narrow screens, more items for wider screens).
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12.3 Role-based Ul

Requires Model Permissions (which are not implemented yet). The same goal
can easily be achieved with multiple web applications, however.

12.3.1 Model Permissions

Model permissions are not implemented yet.

12.3.2 Custom Layout JSPs

openCRX is distributed with 2 default layout JSPs located in the directory
opencrx-core-CRX\opencrx-core-CRX\WEB-INF\config\layout\en_US:

e show-Default.jsp

This layout JSP renders all pages that show information (typically an
Inspector containing information about the current object and all the
grids containing associated information). This layout JSP is generic (it is
provided by openMDX/portal) and it can handle any object.

e edit-Default.jsp
Similarly, this layout JSP renders all pages that are used to edit objects.

If you have a need for specialized screens for a particular object in edit and/or
show mode, you can write your own layout JSP and deploy it to the above-
mentioned directory. The file name of your custom layout JSP determines
which objects (or rather: objects of which class) will be handled by your
custom layout JSP.

Example:

Let's assume you want to replace the default edit screen for openCRX Contacts
(i.e. class org.opencrx.kernel.accountl.Contact) with a custom layout JSP.
Name your file

edit-org.opencrx.kernel.accountl.Contact.jsp

and deploy it to the directory ...\WEB-INF\config\layout\en_US. After restarting
Tomcat or your application server your new layout JSP will be active.

If you develop localized JSPs you can create new directories for the
respective locales and then deploy your localized JSPs there. The

"o fallback algorithms are comparable to those in ui customization.
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13 Integration with Office Application

openCRX provides various technologies that enable you to easily integrate
common office suites like Open Office or Microsoft Office.

13.1 MS Word, OpenOffice Writer, etc.

openCRX supports the JSP-wizard-based generation of RTF documents. You
can generate RTF documents from scratch or merge data with existing RTF
templates. The RTF documents are generated on the fly and can be opened
with any RTF-compatible word processor including OpenOffice Writer and
MS Word.

You can test this feature on our demo server (or on your own installation if you
installed the openCRX Server) with the following steps:

- connect and login as user guest

- navigate to any contact and execute the operation
Tools > Mail Merge --> RTF Document

- the wizard will provide a list of suitable templates and then generate the
RTF document on the fly

-

i~ CRX_Standard_000001_Guest%2C (read-only) - OpenOffice.org Writer Mi=[<

File Edit View Insert Format Table Tools Window Help

B2-relaZ B8R i S |
L

openCRX Sample Wizard — Mail Merge to RTF Document

FiEname CRE Standad B0 GuestioZC.rif
Cualifier NI w EIBEEdIS el v oA

MName Guest,

Mail Merge Counter | TREHNEN

Timestamg Z2008-07-10T13: 2024 M1

Mailing Address | WARHNING: no postal addressavailable

Figure 75: RTF Document generated by merging live data with template

If you installed the openCRX SDK you will find the templates and the JSP
wizard in the following locations:

e <SDK_Install_Dir>\opencrx-2.5.1\core\src\data\org.opencrx\documents
® <SDK_Install_Dir>\opencrx-2.5.1\core\src\data\org.opencrx\wizards\en_US\MailMerge.jsp

With this approach it is quite easy to generate all kinds of documents,
including letters, invoices, purchase orders, etc.
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13.2 MS Excel, Open Office Calc, etc.

openCRX supports both a raw spreadsheet export of data and the JSP-wizard-
based generation of XLS documents. You can generate XLS documents from
scratch or merge data with existing XLS templates. The XLS documents are
generated on the fly and can be opened with any XLS-compatible spreadsheet
program including OpenOffice Calc and MS Excel.

You can test this feature on our demo server (or on your own installation if you
installed the openCRX Server) with the following steps:

connect and login as user guest
navigate to Accounts
execute the operation Reports > Contacts Report as shown below

Contacts Report

Report parameters

Start with name: A
< >
End with name: K
< >
Export max.: 100
< >
I (04 H Cancel ]

Figure 76: Contacts Export Dialog
the Spreadsheet is generated on the fly and can be downloaded from the
openCRX server by clicking on the link provided in the operation result
You might also want to look at the information provided in the chapters
e 11.3.2 Exporting Data to MS Excel / Open Office Calc Files
e 14.1 Standard Reports

13.3 MS Outlook, Thunderbird/Lightning, Sunbird, etc.

See chapter 9 Groupware Services.
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14 Reporting

openCRX provides various technologies that enable you to create reports of a
wide variety, anything from simple ad-hoc reports to large scale bulk reports.

14.1 Standard Reports

Included in the openCRX standard distribution are the following reports:
e Account List (available on Account Filters)
Account Member List (available on Groups)
Activity List (available on Activity Groups and Filters)
Activity List with Follow-Ups (available on Activity Groups and Filters)
Contract List (available on Contract Filters)
Contract List with Positions (available on Contract Filters)

You can install these standard reports into any openCRX Segment with the
wizard Segment Setup. The reports are based on spreadsheet templates. If
you installed the openCRX SDK you will find the templates in the following
location:

<SDK_Install_Dir>\opencrx-2.5.1\core\src\data\org.opencrx\documents\

The templates contain VBA macros to “beautify” the reports. These

i macros will probably not work in Open Office Calc...
n

You can test — for example - the Report Account List with the following steps:

e connect and login as user guest
e navigate to Accounts > Account Filters and select All Accounts
e select the Menu File > Export

14 All Accounts - Account Filter

File Edit View Actions  Security

Profile: : Account List (Excel) i+

[ oK ” Canicel ]

lew Edit Wiew
e click the button [OK] to generate Export.xls
e open Export.xls with Excel (enable Macros) to get an alphabeticallly
sorted list of accounts complete with e-mail address and phone numbers
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14.2 Ad-hoc Reporting
See chapter 11.3.2 Exporting Data to MS Excel / Open Office Calc Files.

Standard office suite know how (and maybe a bit of macro programming)
should get you a long way. Once you're ready to “institutionalize” a report you
can prepare a template and an openCRX Export Profile. Consult the templates
and the Export Profiles provided by the opeCRX distribution for examples.

14.3 Large Scale Reporting

If your task is to produce a large number of reports (e.g. monthly reporting for
all your clients) or reports based on large amounts of data, spreadsheet-based
reporting is probably not the way to go. Maybe you want to generate reports in
a format other than XLS. On the one hand, openCRX already includes libraries
to generate reports and documents in various formats, on the other hand you
can easily add additional libraries to openCRX.

Format |Library / Additional Information

XLS Apache POI / http://poi.apache.org/

PDF iText / http://www.lowagie.com/iText/

RTF Simple RTF Writer / http://www.it-s-easy.com/downloads.htm

Obviously, there are many more possibilities, like for example exporting data
in XML format and then doing some kind of fancy transformation. One such
example is available from http://www.koalix.org/

In terms of how to generate your reports, there are also various options
available depending on your preferences:

e JSP-Based Reporting
This approach is typically recommended if you need on-demand

reporting and the generation of the report does not put an undue burden
on the server. The following screen shot shows an example HTML-report:

Kundsnbszilgs Kundsn-hr. 105341 [Fuglistaliar 23] { Thu Jul 10 14:43:00 CEST 200 vier ez

1031 || meuoereoren || ne perowmen mrdmvezen || Drosen | | Femsersciesse |
[ o etes Beziige rzelgen
Produld i

PA, LFA - \ e
- Tol . Dlscound  VerlEulsprels =
[ Mege postin SV omen — - -
- —

11210 Diessloz] UN 1202 41z 00 4121 20185 213

130050

11120

Blefnzl 25 UM 1203 11505 00_H 11,5351
139071
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17258 021303 130050

16400 B213520
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Z
05005 eics:
5

wh ) dh | dh )

alalol o
1

alaolal o
1

1 n 1 1

[=] [=] (=3 (=3

[ON BN AN

B
11120 Blednel 25 UN 1203 13907 001
11219 D

19420 21332 - e

rleselos] UN 1202 4285 00N

— 104 —


http://www.koalix.org/
http://www.it-s-easy.com/downloads.htm
http://www.lowagie.com/iText/
http://poi.apache.org/

openCRX Admin Guide - Version 2.5.2 Reporting

e Java Program
Large-scale batch reporting can be done with a Java Program (basically
an openCRX client programmed in Java that prepares the desired
reports).

e BI-Reporting Suite
If you plan to use a BI-Reporting Suite (e.g. Crystal Reports, Pentaho,

BIRT, etc.), you should keep in mind that directly accessing the
openCRX database is not a very good idea. We strongly recommend
you either retrieve data through the openCRX API (e.g. with REST) or set
up a dedicated reporting DB (the process to populate such a reporting
DB should retrieve data from the openCRX DB through the openCRX
API). The reason for not accessing the openCRX database directly is the
following one: while the openCRX API is stable, the OO-to-relational
mapping is not and hence the schema of the openCRX DB is subject to
change over time. Hence, if you access the openCRX DB directly you will
have to adapt your reports if the DB schema changes, a potentially
expensive proposition. Furthermore, whenever you access the openCRX
DB directly there is no access control...
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15 Miscellaneous Topics

15.1 SNMP Monitoring

The SNMP agent for the Sun JVM can be enabled as described at
http://java.sun.com/j2se/1.5.0/docs/guide/management/SNMP.html and
http://www.ilikespam.com/blog/monitoring-the-jvm-with-snmp.

1) Put snmp.acl in TOMCAT_LWC_HOME/bin and give read access to the file
for the owner only.

#The communities public and private are allowed access from the local host.
acl = {
{
communities = public, private
access = read-only
managers = localhost
}
}
# Traps are sent to localhost only
trap = {
{
trap-community = public
hosts = localhost
}
}

2) Add the following options to tomcat.sh
-Dcom. sun.management.snmp.port=8161
-Dcom.sun.management.snmp.acl.file=TOMCAT LWC HOME/bin/snmp.acl

3) After startup the variables can be retrieved with
snmpwalk -c public -v2c localhost:8161 .1.3.6.1.4.1.42.2.145.3.163.1.1.4.1.

See http://support.ipmonitor.com/mibs/JVM-MANAGEMENT-
MIB/oids.aspx for a list of all OIDs supported by the JVM.

A simple cron-based monitoring environment can invoke snmpwalk periodically
and send mail if a monitored parameter violates a predefined constraint. Use
gkrellm with the snmp extension (see http://trig.net/gkrellm_snmp.html) or
OpenNMS (see http://www.opennms.org/) for more advanced monitoring
solutions.

This approach only works for the Sun JVM. JRockit does not seem to support
the options -Dcom.sun.management.snmp.*
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15.2 Tomcat w/ openCRX and LDAP-based Authentication
You can connect Tomcat w/ openCRX with OpenLDAP as follows:

e replace the JDBC Realm entry in the file opencrx-core-CRX\opencrx-core-
CRX\META-INF\context.xml with the following entry:

<Realm
className="org.apache.catalina.realm.JNDIRealm"
debug="99"

connectionName="cn=Manager, dc=opencrx,dc=org"
connectionPassword="secret"
connectionURL="1ldap://localhost:389"
userPassword="userPassword"
userPattern="cn={0}, ou=people, dc=opencrx,dc=org"
roleBase="ou=groups, dc=opencrx, dc=org"
roleName="cn"
roleSearch=" (uniqueMember={0})"

/>

e Users must be entered into your LDAP server as follows (userPattern):

# Users

dn: cn=guest, ou=people,dc=opencrx,dc=org
objectClass: organizationalPerson

sn: guest

cn: guest

userPassword: opencrx

dn: cn=admin-Root, ou=people,dc=opencrx,dc=org
objectClass: organizationalPerson

sn: admin-Root

cn: admin-Root

userPassword: opencrx

dn: cn=admin-Standard, ou=people,dc=opencrx,dc=org
objectClass: organizationalPerson

sn: admin-Standard

cn: admin-Standard

userPassword: opencrx

e Groups must be entered into your LDAP server as follows (roleBase,
roleName, and roleSearch):

# Groups

dn: ou=groups, dc=opencrx,dc=org
objectClass: organizationalUnit
ou: groups

dn: cn=OpenCrxRoot, ou=groups,dc=opencrx,dc=org
objectClass: groupOfUniqueNames

cn: OpenCrxRoot

uniqueMember: cn=admin-Root, ou=people,dc=opencrx,dc=org

dn: cn=OpenCrxAdministrator, ou=groups,dc=opencrx,dc=org
objectClass: groupOfUniqueNames

cn: OpenCrxAdministrator

uniqueMember: cn=admin-Standard, ou=people,dc=opencrx,dc=org

dn: cn=OpenCrxUser, ou=groups,dc=opencrx,dc=org
objectClass: groupOfUniqueNames

cn: OpenCrxUser

uniqueMember: cn=guest,ou=people,dc=opencrx,dc=o0rg
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16 Next Steps

You might want to have a look at some of the additional documentation
published at http://www.opencrx.org/documents.htm.
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